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1. What is GeoGebra?

GeoGebra is dynamic mathematics software that joins geometry, algebra and calculus. It is
developed for learning and teaching mathematics in schools by Markus Hohenwarter and an
international team of programmers.

1.1. Multiple Views for Mathematical Objects

GeoGebra provides three different views of mathematical objects: a Graphics View, a,
numeric Algebra View, and a Spreadsheet View. They allow you to display mathematical
objects in three different representations: graphically (e. g., points, function graphs),
algebraically (e. g., coordinates of points, equations), and in spreadsheet cells. Thereby, all
representations of the same object are linked dynamically and adapt automatically to
changes made to any of the representations, no matter how they were initially created.
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1.1.1. Graphics View

Using the construction tools available in the Toolbar you can do geometric constructions in
the Graphics View with the mouse. Select any construction tool from the Toolbar and read
the Toolbar Help (next to the Toolbar) in order to find out how to use the selected tool. Any
object you create in the Graphics View also has an algebraic representation in the Algebra
View.



Note: After activating the tool % Move you are able to move objects in the Graphics View by
dragging them with the mouse. At the same time, their algebraic representations are
dynamically updated in the Algebra View.

Every icon in the Toolbar represents a toolbox that contains a selection of similar
construction tools. In order to open a toolbox, you need to click on the small arrow in the
lower right corner of the Toolbar icon.

Hint: Construction tools are organized by the nature of resulting objects or the functionality
of the tools. You will find tools that create different types of points in the Point Toolbox
(default icon ") and tools that allow you to apply geometric transformations in the
Transformation Toolbox (default icon \)

1.1.2. Algebra View

Using the Input Bar you can directly enter algebraic expressions in GeoGebra. After hitting
the Enter-key your algebraic input appears in the Algebra View while its graphical
representation is automatically displayed in the Graphics View.

Example: The input £ (x) = x"2 gives you the function f in the Algebra View and its
function graph in the Graphics View.

In the Algebra View, mathematical objects are organized as free and dependent objects. If
you create a new object without using any other existing objects, it is classified as a free
object. If your newly created object was created by using other existing objects, it is
classified as a dependent object.

Hint: If you want to hide the algebraic representation of an object in the Algebra View, you
may specify the object as an auxiliary object: Right click (Mac OS: Ctrl-click) on the
corresponding object in the Algebra View and select Properties from the appearing Context
Menu. On tab Basic of the Properties Dialog you may specify the object as an Auxiliary
Object. By default, auxiliary objects are not shown in the Algebra View, but you can change
this setting by selecting the item Auxiliary Objects from the View menu.

Note that you are able to modify objects in the Algebra View as well: Make sure that you
activate the % Move tool before you double click on a free object in the Algebra View. In
the appearing text box you can directly edit the algebraic representation of the object. After
hitting the Enter-key, the graphical representation of the object will automatically adapt to
your changes.

If you double click on a dependent object in the Algebra View, a dialog window appears
allowing you to Redefine the object.

GeoGebra also offers a wide range of commands that can be entered into the Input Bar. You
can open the list of commands in the right corner of the Input Bar by clicking on the button
Command. After selecting a command from this list (or typing its name directly into the
Input Bar) you can press the F1-key to get information about the syntax and arguments
required to apply the corresponding command.



1.1.3. Spreadsheet View

In GeoGebra’s Spreadsheet View every cell has a specific name that allows you to directly
address each cell. For example, the cell in column A and row 1 is named A1.

Note: These cell names can be used in expressions and commands in order to address the
content of the corresponding cell.

In the spreadsheet cells you can enter not only numbers, but all types of mathematical
objects that are supported by GeoGebra (e. g., coordinates of points, functions, commands).
If possible, GeoGebra immediately displays the graphical representation of the object you
entered in a spreadsheet cell in the Graphics View as well. Thereby, the name of the object
matches the name of the spreadsheet cell used to initially create it (e. g., A5, C1).

Note: By default, spreadsheet objects are classified as auxiliary objects in the Algebra View.
You can show or hide these auxiliary objects by selecting Auxiliary Objects from the View
menu.

1.2. GeoGebra as a Tool for Teaching and Learning Mathematics

1.2.1. Customizing the User Interface

The user interface of GeoGebra can be customized by using the View menu. For example,
you can hide different parts of the interface (e. g., the Algebra View, Spreadsheet View, or
Input Bar) by checking or un-checking the corresponding menu item in the View menu.

Showing and Hiding Objects

You may show or hide objects in the Graphics View in different ways.

e You may use tool © Show/Hide Object to show or hide objects.

e Open the Context Menu and select item "=/ Show Object to change the visibility
status of the selected object.

e Inthe Algebra View, the icon to the left of every object shows its current visibility
state (Y shown or " hidden). You may directly click on the little marble icon in
order to change the visibility status of an object.

e You can also use the tool ¥5 Check Box to Show/Hide Objects in order to show or
hide one or several objects.

Customizing the Graphics View

In order to adjust the visible part of the drawing pad in the Graphics View, you can drag the
drawing pad by using tool ¢ Move Drawing Pad and use the following ways of zooming:
e You may use the tools ®, Zoom In and B\ Zoom Out in order to zoom in the Graphics
View.
Note: The position of your click determines the center of zoom.
e You may use the scroll wheel of your mouse in order to zoom in the Graphics View.



e You may use keyboard shortcuts to zoom in (Ctrl +) and to zoom out (Ctrl -).

e After right clicking (Mac OS: Ctri-click) on an empty spot on the drawing pad a
Context Menu appears which allows you to Zoom.

e You may specify a zoom rectangle by right clicking (Mac OS: Cmd - click) on an empty
spot in the Graphics View and dragging the mouse to the opposite corner of your
desired zoom rectangle. Release the mouse button in order to finish the zoom
rectangle, which will then automatically adjust to fill all the space in the Graphics
View.

You can also show or hide the coordinate axes and a coordinate grid in the Graphics View by
using the View menu.

Note: Another way of showing or hiding the axes and the grid is by right clicking (Mac OS:
Ctrl-click) on the drawing pad and selecting the corresponding items 1 Axes or ¥ Grid from
the appearing Context Menu.

Customizing Coordinate Axes and Grid

The coordinate axes and grid can be customized using the Properties Dialog of the Graphics
View. After right clicking (Mac OS: Ctrl-click) on the drawing pad, you can open this dialog
window by selecting Properties from the appearing Context Menu of the Graphics View.

e On tab Axes, you can, for example, change the line style and units of the coordinate
axes, and set the distance of the tickmarks to a certain value. Note that you can
customize both axes individually, by clicking on tabs xAxis or yAxis. Furthermore, you
can also change the ratio between the axes and hide or show the axes individually.

e On tab Grid, you can, for example, change the color and line style of the coordinate
grid, and set the distance for grid lines to a certain value. In addition, you may also
set the grid to be Isometric.

Note: Scaling the axes is possible in every mode by pressing and holding the Shift-key (PC:
also Ctrl-key) while dragging the axis.

Note: The Properties Dialog of the Graphics View is different from the Properties Dialog for
objects.

Customizing the Toolbar

The Toolbar can be customized by selecting Customize Toolbar... from the Tools menu.
Select the tool or toolbox you want to remove from the Toolbar in the list on the left hand
side of the appearing dialog window and click button Remove > in order to remove the
tool/toolbox from the Toolbar.

Note: You can restore the default Toolbar by clicking on the button Restore Default Toolbar
in the left lower corner of the dialog window.



1.2.2. The Properties Dialog

The Properties Dialog allows you to modify properties of objects (e. g., size, color, filling, line
style, line thickness, visibility).

You can open the Properties Dialog in several ways:
e Right click (Mac OS: Ctrl-click) on an object and select @& Properties... from the
appearing Context Menu.
e Select item 2 Properties from the Edit menu.
e Selectthe % Move tool and double click on an object in the Graphics View. In the
appearing Redefine dialog window, click on the button Properties....

In the Properties Dialog objects are organized by types (e. g., points, lines, circles) in the list
on the left hand side, which makes it easier to handle large numbers of objects. You need to
select one or more objects from this list in order to change its/their properties.

Note: By clicking on a heading in the list of objects (e. g., Point) you can select all objects of
this type and therefore, quickly change the properties for all these objects.

You can modify the properties of selected objects using the tabs on the right hand side (e.
g., Basic, Color, Style, Advanced).

Note: Depending on the selection of objects in the list, a different set of tabs may be
available.

Close the Properties Dialog when you are done with changing properties of objects.

1.2.3. The Context Menu

The Context Menu provides a quick way to change the behavior or advanced properties of
an object. Right click (Mac OS: Ctrl-click) on an object in order to open its Context Menu. For
example, it allows you to change the object’s algebraic notation (e. g., polar or Cartesian
coordinates, implicit or explicit equation) and to directly access features like o) Rename, i/
Delete, # Trace On, Animation On, or [# Copy to Input Bar.

Note: If you open the Context Menu for a point in the Graphics View, it gives you the option
Trace to Spreadsheet (only if the Spreadsheet View is active). Once selected, this feature

allows you to record the coordinates of the point in the Spreadsheet View if it is moved.

Note: Selecting @& Properties... in the Context Menu opens the Properties Dialog, where you
can change the properties of all objects used.
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1.3. GeoGebra as a Presentation Tool

1.3.1. The Navigation Bar

GeoGebra offers a Navigation Bar that allows you to navigate through the construction
steps of a prepared GeoGebra file. Select item Navigation Bar for Construction Steps in the
View menu in order to display the Navigation Bar at the bottom of the Graphics View.

The Navigation Bar provides a set of navigation buttons and displays the number of
construction steps (e. g., 2/ 7 means that currently the second step of a total of 7
construction steps is displayed):
e [ putton: go back to step 1
e “Flbutton: go back step by step
e [ putton: go forward step by step
o [ putton: go to the last step
e [ Play: automatically play the construction step by step
Note: You may change the speed of this automatic play feature using the text box to
the right of the ™ Play button.
o [0 pguse: pause the automatic play feature
Note: This button only appears after you click on the Play button.
e [l button: This button opens the Construction Protocol.

1.3.2. The Construction Protocol

You can access the interactive Construction Protocol by selecting item Construction Protocol
from the View menu. It is a table that shows all construction steps. The Construction
Protocol allows you to redo a prepared construction step by step using the Navigation Bar
at the bottom of the Construction Protocol dialog.

Navigating and Modifying the Construction Protocol

You may use the keyboard to navigate in the Construction Protocol:

e Use the 1 up arrow of your keyboard to go to the previous construction step.

e Usethe | down arrow of you keyboard to go to the next construction step.

e Use the Home key to go to the beginning of the Construction Protocol.

e Use the End key to go to the end of the Construction Protocol.

e Use the Delete key in order to delete the selected construction step.
Note: This may also affect other objects that depend on the selected
object/construction step.

You may also use the mouse in order to navigate in the Construction Protocol:
e Double click a row in order to select a construction step.
e Double click the header of any column in order to go to the start of the Construction
Protocol.
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e Dragand drop a row in order to move a construction step to another position in the
Construction Protocol.
Note: This is not always possible due to the dependencies between different objects.
e Right click a row in order to open the Context Menu for the object of this
construction step.

Note: You can insert construction steps at any position. Select the construction step below
you would like to insert a new construction step. Leave the Construction Protocol window
open while you create a new object. This new construction step is immediately inserted into
the selected position of the Construction Protocol.

Using the column Breakpoint in the View menu of the Construction Protocol window, you
are able to define certain construction steps as Breakpoints. This allows you to group several
objects together. When navigating through your construction using the Navigation Bar,
groups of objects are shown at the same time.

Note: You may switch the different columns of the Construction Protocol on and off by
using the View menu of the Construction Protocol window.

Exporting the Construction Protocol as a Webpage

GeoGebra allows you to export the Construction Protocol as a webpage. First, you need to
open the Construction Protocol using the View menu. Then, you can open the File menu of
the appearing Construction Protocol window and select item Export as Webpage.

In the export window of the Construction Protocol you can enter Title, Author, and a Date
for the construction and choose whether or not you want to include a picture of the
Graphics View and the Algebra View. In addition, you can also choose to export a Colorful
Construction Protocol. This means that objects in the Construction Protocol will match the
color of the corresponding objects in the construction.

Note: The exported HTML file can be viewed with any Internet browser (e. g. Firefox,
Internet Explorer) and edited with many text processing systems (e. g. OpenOffice Writer).

1.3.3. Customize the Settings

GeoGebra allows you to change and save settings using the Options menu. For example, you
may change the Angle Unit from Degree to Radians, or change the Point Style, Checkbox
Size, and Right Angle Style. In addition, you may change how Coordinates are displayed on
screen and which objects are labeled (Labeling).

Please see the section about the Options menu for more information.

You can save your customized settings by selecting item @ save Settings from the Options
menu. After doing so, GeoGebra will remember your customized settings and use them for
every new GeoGebra file you create.

Note: You may restore the default settings by selecting Restore Default Settings from the
Options menu.
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Note: If you use GeoGebra as a presentation tool, you might want to increase the Font Size
(Options menu) so your audience can easily read text and labels of objects.

1.4. GeoGebra as an Authoring Tool

1.4.1. Printing Options

Printing the Graphics View

GeoGebra allows you to print the Graphics View of your constructions. You can find the
corresponding item Print Preview in the File menu. In the appearing Print Preview dialog
window, you can specify the Title, Author, and a Date for the construction. In addition, you
can set the Scale of your printout (in cm) and change the Orientation of the paper used
(portrait or landscape).

Note: In order to update the Print Preview after you made changes to the text or layout of
the printout, you need to press the Enter-key.

Printing the Construction Protocol

If you want to print the Construction Protocol, you first need to open the Construction
Protocol dialog window by using the View menu. Then, you can open the Print Preview
window of the Construction Protocol from the File menu of this new window.

Again, you may enter Title, Author, and a Date or change the Scale or paper Orientation
before printing your Construction Protocol.

Note: You may switch the different columns Name, Definition, Command, Algebra, and
Breakpoint of the Construction Protocol on and off by using the View menu of the
Construction Protocol dialog window.

1.4.2. Creating Pictures of the Graphics View

Saving the Graphics View as a Picture

You can save the Graphics View of your constructions as a picture file on your computer.
Note: The full Graphics View will be saved as a picture. If your construction does not use all
the available space in the Graphics View, you might want to...

e ..usetools ¥ Move Drawing Pad, ®, Zoom In, and/or B, Zoom Out in order to place
your construction in the upper left corner of the Graphics View. Afterwards, you may
reduce the size of the GeoGebra window by dragging one of its corners with the
mouse.

e ... use the selection rectangle in order to specify which part of the Graphics View
should be exported and saved as a picture.
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e You may create points called Export_1 and Export_2, which will be used to define
diagonally opposite corners of the export rectangle.
Note: Points Export; and Export, must be within the visible area of the Graphics
View.

In the File menu, select item Export before clicking on item (=] Graphics View as Picture. In
the appearing dialog window you may specify the Format, Scale (in cm), and the Resolution
(in dpi) of the output picture file.

Note: The true size of the exported image is shown at the bottom of the export window just
above the buttons, both in centimeters and pixel.

Please find more information about the different picture files available in section Export - (=]
Graphics View as Picture (png, eps)....

Copying the Graphics View to Clipboard

There are different ways of copying the Graphics View to your computer’s clipboard:
e Inthe Edit menu, you may select item [= Graphics View to Clipboard.
e Inthe File menu, you first need to select item Export, before you can click on item
[ Graphics View to Clipboard.
e Inthe Export Graphics View as Picture dialog window (menu File — Export —
= Graphics View as Picture (png, eps)...) you may click on the button Clipboard.

This feature copies a screenshot of the Graphics View to your system's clipboard as a PNG
(see PNG format) picture. This picture can be pasted into other documents (e. g. a word
processing document).

Note: In Order to export your construction at a certain scale (in cm) please use the menu
item (& Graphics View as Picture in the File menu, Export.

1.4.3. Creating Interactive Webpages

GeoGebra allows you to create interactive webpages, so called Dynamic Worksheets, from
your files. In the File menu, you need to select item Export before you can click on item
= Dynamic Worksheet as Webpage (html). This opens the export dialog window for
Dynamic Worksheets:
e At the top of the export window you can enter the Title, Author, and a Date for your
Dynamic Worksheet.
e Tab General allows you to add some text above and below the dynamic construction
(e. g., a description of the construction and some tasks). You can also determine if
the construction itself may be included directly into the webpage or if it can be
opened by clicking on a button.
e Tab Advanced allows you to change the functionality of the dynamic construction (e.
g., show a reset icon, double click should open the GeoGebra application window) as
well as to modify the user interface shown in the interactive applet (e. g., show the
Toolbar, modify height and width).
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Note: If the size of your applet is too big to fit on a computer screen with standard
resolution (1024 x 768), you may want to resize it before the actual export as a
Dynamic Worksheet.

Note: Several files are created when you export a Dynamic Worksheet:
o HTML file (e. g. circle.html) — this file includes the worksheet itself
e GGBfile (e. g. circle.ggb) — this file includes your GeoGebra construction
e JAR (several files) — these files include GeoGebra and make your worksheet
interactive
All these files (e. g. circle.html, circle.ggb and the geogebra.jar files) have to be in one folder
(directory) to let the dynamic construction work.

The exported HTML file (e. g. circle.html) can be viewed with any Internet browser (e. g.
Mozilla, Internet Explorer, Safari). In order to let the dynamic construction work, Java has to
be installed on the computer. You can get Java from http://www.java.com without charge. If
you want to use your Dynamic Worksheet in your school's computer network, ask your local
network administrator to install Java on the computers.

Note: You can edit the Dynamic Worksheet's text with many word processing systems (e. g.
FrontPage, OpenOffice Writer) by opening the exported HTML file. You may also edit the
Dynamic Worksheet's applet by opening the GGB file in GeoGebra and saving it with the
same name afterwards.
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2. Geometric Input

2.1. General Notes

The Graphics View shows the graphical representation of mathematical objects (e. g.,
points, vectors, segments, polygons, functions, curves, straight lines, conic sections).
Whenever the mouse is moved over one of these objects a description appears as a roll-
over text and the object is highlighted.

There are several tools/modes to tell GeoGebra how it should react to mouse input in the
Graphics View (see section Construction Tools). For example, clicking on the drawing pad
can create a new point (see tool ** New Point), intersect two objects (see tool > Intersect
Two Objects), or create a circle (see "’ Circle tools).

2.2. Construction Tools

The following construction tools or modes can be activated by clicking on the buttons of the
Toolbar. You can click on the small arrow in the lower right corner of an icon to open a
Toolbox with similar other tools.

Note: With most construction tools you can easily create new points by clicking on empty
spaces on the drawing pad.

Selecting Objects

To select an object means to click on it with the mouse after selecting the % Move tool.

If you want to select several objects at the same time, you could draw a selection rectangle:
Select the % Move tool and click on the position of the first corner of your desired selection
rectangle. Hold the left mouse key pressed down and move the pointer to the position of
the diagonally opposite corner of your desired selection rectangle. After releasing the mouse
button, all objects within the selection rectangle are selected.

Note: By holding the Ctrl-key (Mac OS: Cmd-key) while clicking on different objects, you can
select several objects at the same time.

Fast Renaming of Objects

To quickly rename a selected or newly created object just start typing to open the Rename
dialog for this object. Then, type in the new name of the selected object and click on the OK
button.
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2.2.1. General Tools

Copy Visual Style

This tool allows you to copy visual properties (e. g., color, size, line style) from one object to
one or more other objects. To do so, first select the object whose properties you want to
copy. Then, click on all other objects that should adopt these properties.

“~ Delete Object

Click on any object you want to delete (also see command Delete).
Note: You can use the “~# Undo button if you accidentally deleted the wrong object.

% Move

Drag and drop free objects with the mouse. If you select an object by clicking on it in
k' Move mode, you may...
e .. delete the object by pressing the Delete-key
e .. move the object by using the arrow keys (see section Manual Animation)
Note: You can quickly activate the & Move tool by pressing the Esc-key of your keyboard.

i

Drag and drop the drawing pad in the Graphics View to change its visible area.
Note:
e You can also move the drawing pad by pressing the Shift-key (MS Windows: also Ctrl-
key) and dragging it with the mouse in any mode.
¢ In this mode you can also scale each of the axes by dragging it with the mouse.

Move Drawing Pad

56
24 %
12 ™% Record to Spreadsheet

This tool allows you to move an object and to record a sequence of its values in the
Spreadsheet View. This tool works for numbers, points, and vectors.

Note: GeoGebra will use the first two empty columns of the Spreadsheet View to record the
values of the selected objects.

?
a=1 Relation

Select two objects to get information about their relation in a pop-up window (also see
command Relation).
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. Rotate around Point

Select the center point of the rotation first. Then, you may rotate free objects around this
point by dragging them with the mouse (also see command Rotate).

Show / Hide Label

Click on an object to show or hide its label.

&

-~ Show/Hide Object

Select the object you want to show or hide after activating this tool. Then, switch to another
tool in order to apply the visibility changes to this object.

Note: When you activate this tool, all objects that should be hidden are displayed in the
Graphics View highlighted. In this way, you can easily show hidden objects again by
deselecting them before switching to another tool.

Y

Zoom In

Click on any place on the drawing pad to zoom in (also see section Customizing the Graphics
View).
Note: The position of your click determines the center of zoom.

=Y

Zoom Out

Click on any place on the drawing pad to zoom out (also see section Customizing the
Graphics View).
Note: The position of your click determines the center of zoom.

2.2.2. Point Tools

>.( Intersect Two Objects

Intersection points of two objects can be created in two ways (also see command Intersect).
e Selecting two objects creates all intersection points (if possible).
e Directly clicking on an intersection of the two objects creates only this single
intersection point .
Note: For segments, rays, or arcs you may specify whether you want to Allow outlying
intersections on tab Basic of the Properties Dialog. This can be used to get intersection
points that lie on the extension of an object. For example, the extension of a segment or a
ray is a straight line.
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L
L]

*  Midpoint or Center

You may click on either two points or one segment to get its midpoint. You can also click on
a conic section (circle or ellipse) in order to create its center point (also see commands
Center and Midpoint).

A
® New Point

Click on the drawing pad in the Graphics View in order to create a new point. The
coordinates of the point are fixed when the mouse button is released.
Note:
e By clicking on a segment, straight line, polygon, conic section, function, or curve you
can create a point on this object (also see command Point).
e Clicking on the intersection of two objects creates this intersection point (also see
tool X Intersect Two Objects and command Intersect).

2.2.3. Vector Tools

-

Select the starting point and then the end point of the vector (also see command Vector).

Vector between Two Points

~" Vector from Point

Select a point A and a vector v to create the new point B = A + v as well as the vector from A
to B (also see command Vector).

2.2.4. Segment Tools

/.

Select two points A and B in order to create a segment between A and B (also see command
Segment).
Note: In the Algebra View, the segment's length is displayed.

Segment between Two Points

o Segment with Given Length from Point

Click on a point A that should be the starting point of the segment. Specify the desired
length a of the segment in the appearing window (also see command Segment).

Note: This tool creates a segment with length a and endpoint B which may be rotated
around the starting point A by using tool % Move.

19



2.2.5. Ray Tool

Ray through Two Points

Selecting two points A and B creates a ray starting at A through B (also see command Ray).
Note: In the Algebra View the equation of the corresponding line is displayed.

2.2.6. Polygon Tools

T
*  Polygon

Successively select at least three points which will be the vertices of the polygon. Then, click
the first point again in order to close the polygon (also see command Polygon).
Note: In the Algebra View, the polygon's area is displayed.

._I

-
“« Regular Polygon

Select two points A and B and specify the number n of vertices in the text field of the
appearing dialog window. This gives you a regular polygon with n vertices including points A
and B (also see command Polygon).

2.2.7. LineTools

B Angle Bisector

Angle bisectors can be defined in two ways (also see command AngleBisector):
e Selecting three points A, B, and C produces the angle bisector of the enclosed angle,
where point B is the apex.
e Selecting two lines produces their two angle bisectors.
Note: The direction vectors of all angle bisectors have length 1.

,4;
& Best Fit Line

Create the best fit line for a set of points in the following ways (also see command FitLine):
e Create a selection rectangle that contains all points.
e Select a list of points to create their corresponding best fit line.

/ Line through Two Points

Selecting two points A and B creates a straight line through A and B (also see command
Line).
Note: The line’s direction vector is (B - A).
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-
— Parallel Line

Selecting a line g and a point A defines a straight line through A parallel to g (also see
command Line).
Note: The line’s direction is the direction of line g.

'X: Perpendicular Bisector

Click on either a segment s or two points A and B in order to create a perpendicular bisector
(also see command PerpendicularBisector).

Note: The bisector’s direction is equivalent to the perpendicular vector of segment s or AB
(also see command PerpendicularVector).

.
— Perpendicular Line

Selecting a line g and a point A creates a straight line through A perpendicular to line g (also
see command PerpendicularLine).

Note: The line’s direction is equivalent to the perpendicular vector of g (also see command
PerpendicularVector).

* "% Polar or Diameter Line

This tool creates the polar or diameter line of a conic section (also see command Polar).
e Select a point and a conic section to get the polar line.
e Select aline or a vector and a conic section to get the diameter line.

il

’O Tangents

Tangents to a conic section can be produced in several ways (also see command Tangent):
e Selecting a point A and a conic ¢ produces all tangents through A to c.
e Selecting a line g and a conic ¢ produces all tangents to c that are parallel to line g.
e Selecting a point A and a function f produces the tangent line to fin x = x(A).
Note: x(A) represents the x-coordinate of point A. If point A lies on the function
graph, the tangent runs through point A.

2.2.8. Conic Section Tools

@ Circle with Center and Radius

Select the center point M and enter the radius in the text field of the appearing dialog
window (also see command Circle).
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R ]
Q Circle with Center through Point

Selecting a point M and a point P defines a circle with center M through P (also see
command Circle).
Note: The circle’s radius is the distance MP.

O Circle through Three Points

Selecting three points A, B, and C defines a circle through these points (also see command
Circle).
Note: If the three points lie on one straight line, the circle degenerates to this line.

.".- -.\.

[ o
- Compass

UK English: Compasses

Select a segment or two points to specify the radius. Then, click on a point that should be
the center of the new circle.

W
“:’J Conic through Five Points

Selecting five points produces a conic section through these points (also see command
Conic).
Note: If four of these five points lie on a line, the conic section is not defined.

o)
2/ Ellipse

Select the two foci of the ellipse. Then, specify a third point that lies on the ellipse (also see
command Ellipse).

L)
S

. Hyperbola

Select the two foci of the hyperbola. Then, specify a third point that lies on the hyperbola
(also see command Hyperbola).

~~_ Parabola

Select a point and the directrix of the parabola (also see command Parabola).

2.2.9. Arc and Sector Tools

Note: In GeoGebra, the algebraic value of an arc is its length. The value of a sector is its area.
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'.1 Circular Arc with Center between Two Points

First, select the center point M of the circular arc. Then, select the starting point A of the
arc, before you select a point B that specifies the length of the arc (also see command
CircularArc).

Note: While point A always lies on the circular arc, point B does not have to lie on it.

Q Circular Sector with Center between Two Points

First, select the center point M of the circular sector. Then, select the starting point A of the
sector’s arc, before you select a point B that specifies the length of the sector’s arc (also see
command CircularSector).

Note: While point A always lies on the sector’s arc, point B does not have to lie on it.

-
J Circumcircular Arc through Three Points

Selecting three points A, B, and C creates a circular arc through these points. Thereby, point
A is the starting point of the arc, point B lies on the arc, and point C is the endpoint of the
arc (also see command CircumcircularArc).

e

¥ Circumcircular Sector through Three Points

Selecting three points A, B, and C creates a circular sector through these points. Thereby,
point A is the starting point of the sector’s arc, point B lies on the arc, and point Cis the
endpoint of the sector’s arc (also see command CircumcircularSector).

e

*  Semicircle

Select two points A and B to create a semicircle above the segment AB (also see command
Semicircle).

2.2.10. Number and Angle Tools

‘5:' Angle

With this tool you can create angles in different ways (also see command Angle):
e Click on three points to create an angle between these points. The second point
selected is the vertex of the angle.
e Click on two segments to create the angle between them.
e Click on two lines to create the angle between them.
e Click on two vectors to create the angle between them.
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e Click on a polygon to create all angles of this polygon.
Note: If the polygon was created by selecting its vertices in counter clockwise
orientation, the Angle tool gives you the interior angles of the polygon.
Note: Angles are created in counter clockwise orientation. Therefore, the order of selecting
these objects is relevant for the Angle tool. If you want to limit the maximum size of an
angle to 180°, un-check Allow Reflex Angle on tab Basic of the Properties Dialog.

< Angle with Given Size

Select two points A and B and type the angle’s size into the text field of the appearing
window (also see command Angle).
Note: This tool creates a point C and an angle a, where a is the angle ABC.

Eﬁ] Area

This tool gives you the area of a polygon, circle, or ellipse as a number and shows a dynamic
text in the Graphics View (also see command Area).

C'I'I'l'.

- Distance or Length

This tool gives you the distance between two points, two lines, or a point and a line as a
number and shows a dynamic text in the Graphics View. It can also give you the length of a
segment, the circumference of a circle, or the perimeter of a polygon (also see commands
Distance and Length).

a=2
*~ Slider
Click on any free place in the Graphics View to create a slider for a number or an angle. The
appearing dialog window allows you to specify the Name, Interval [min, max], and
Increment of the number or angle, as well as the Alignment and Width of the slider (in pixel).

Note: In the Slider dialog window you can enter a degree symbol ° or pi (i) for the interval
and increment by using the following keyboard shortcuts:

e Alt-O (Mac OS: Ctrl-0O) for the degree symbol °

e Alt-P (Mac OS: Ctrl-P) for the pi symbol t

The position of a slider may be absolute in the Graphics View (this means that the slider is
not affected by zooming, but always remains in the visible part of the Graphics View) or
relative to the coordinate system (see Properties Dialog of the corresponding number or
angle).

Note: In GeoGebra, a slider is the graphical representation of a free number or free angle.

You can easily create a slider for any existing free number or angle by showing this object in
the Graphics View (see Context Menu; see tool "= Show/Hide Object).
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/ Slope

This tool gives you the slope of a line and shows a slope triangle in the Graphics View (also
see command Slope).

2.2.11. Boolean Variable Tool

8 . .
Gls Check Box to Show/Hide Objects

Clicking in the Graphics View creates a check box (see section Boolean Variables and
Operations) that allows you to show and hide one or more objects. In the appearing dialog
window you can specify which objects should be affected by the check box.

Note: You may select these objects from the list provided in the dialog window or select
them with the mouse in any view.

2.2.12. Locus Tool

5:\ Locus

Select a point B that depends on another point A and whose locus should be drawn. Then,
click on point A to create the locus of point B (also see command Locus).
Note: Point A has to be a point on an object (e. g. line, segment, circle).

Example:
o Typef(x) = x*2 - 2 x - 1intothe Input Bar and press the Enter-key.

e Place a new point A on the x-axis (see tool ** New Point; see command Point).
e C(Create pointB = (x(A), f'(x(A))) thatdependson point A.

e Select tool & Locus and successively click on point B and point A.

e Drag point A along the x-axis to see point B moving along its locus line.

2.2.13. Geometric Transformation Tools

The following geometric transformations work for points, lines, conic sections, polygons,
and images.

**  Dilate Object from Point by Factor
UK English: Enlarge Object from Point by Factor
Select the object to be dilated. Then, click on a point to specify the dilation center and enter

the dilation factor into the text field of the appearing dialog window (also see commands
Dilate (US) and Enlarge (UK)).
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L ]
x Reflect Object about Line
UK English: Reflect Object in Line

Select the object you want to reflect. Then, click on a line to specify the mirror/line of
reflection (also see command Reflect).

L]
*  Reflect Object about Point

UK English: Reflect Object in Point

Select the object you want to reflect. Then, click on a point to specify the mirror/point of
reflection (also see command Reflect).

i' -
A Reflect Point about Circle

UK English: Reflect Point in Circle

This tool allows you to invert a point in a circle. Select the point you want to invert. Then,
click on a circle to specify the mirror/circle of inversion (also see command Reflect).

«" * Rotate Object around Point by Angle

Select the object you want to rotate. Then, click on a point to specify the center of rotation
and enter the rotation angle into the text field of the appearing dialog window (also see
command Rotate).

~ Translate Object by Vector

Select the object you want to translate. Then, click on the translation vector (also see
command Translate).

2.2.14. Text Tool

C
Insert Text

With this tool you can create static and dynamic text or LaTeX formulas in the Graphics View
(also see section Text Commands).

At first, you need to specify the location of the text in one of the following ways:
e Click in the Graphics View to create a new text at this location.
e C(Click on a point to create a new text that is attached to this point.

Then, a dialog appears where you may enter your text.
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Note: You may specify the position of a text as absolute on screen or relative to the
coordinate system on tab Basic of the Properties Dialog.

Static text does not depend on any mathematical objects and is usually not affected by
changes of the construction.

Dynamic text contains values of objects that automatically adapt to changes made to these
objects.

Mixed text is a combination of static and dynamic text. In order to create a mixed text you
may enter the static part of the text using the keyboard (e. g., Point A =). Then, click on
the object whose value you want to display in the dynamic part of the text.

Note: GeoGebra automatically adds the syntax ("Point A = " + A)necessary to create
your mixed text: quotation marks around the static part of the text and a plus (+) symbol to
connect the different parts of the text.

Input Description
This is static text Static text
A Dynamic text (if point A exists)
"Point A = " + A Two-part mixed text using the value of point A
" " I Three-part mixed text using the value of
a = + a + cm
number a

Note: If an object with the name xx already exists and you want to create a static text using
the object’s name, you need to enter it with quotation marks ("xx"). Otherwise, GeoGebra
will automatically create a dynamic text that gives you the value of object xx instead of its
name. However, you can type any text that doesn’t match any existing object’s name
without the quotation marks.

Note: Within a mixed text, the static part needs to be in between a pair of quotation marks.
Different parts of a text (e. g., static and dynamic parts) need to be connected using plus (+)
symbols.

LaTeX Formulas

In GeoGebra you can write formulas as well. To do so, check the box LaTeX formula in the
dialog window of the *i Insert Text tool and enter your formula in LaTeX syntax.

Note: In order to create text that contains a LaTeX formula as well as static text you may
enter the static part of the text and then add the LaTeX formula in between a set of dollar
symbols (S).

Example: The length of the diagonal is S$\sqrt{ 2 }S$.

You can select the syntax for common formula symbols from the drop-down menu next to
the LaTeX checkbox. This inserts the corresponding LaTeX code into the text field and places
the cursor in between a set of curly brackets. If you would like to create dynamic text within
the formula, you need to click on an object causing GeoGebra to insert its name as well as
the syntax for mixed text.
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Some important LaTeX commands are explained in following table. Please have a look at any
LaTeX documentation for further information.

LaTeX input Result
a \cdot b

QD
(e

\frac{a}{b}

a

b
\sqrt{x} \/;
\sqrt [n] {x} 8/x
\vec{v} v
\overline{AB} KE
x~{2} x2
a {1} a
\sin\alpha + :
\cos\beta sina +cos

b
\int_{a}*{b} x dx [ xdx
\sum_{i=1}"{n} 12 Pk

2.2.15. Image Tool

4 B
©™ Insert Image

This tool allows you to insert an image into the Graphics View.
First, specify the location of the image in one of the following two ways:
e Click in the Graphics View to specify the position of the image’s lower left corner.
e Click on a point to specify this point as the lower left corner of the image.
Then, a file-open dialog appears that allows you to select the image file from the files saved
on your computer.

Note: After selecting the tool 28 Insert Image, you can use the keyboard shortcut Alt-click in
order to paste an image directly from your computer’s clipboard into the Graphics View.

Properties of Images

The position of an image may be absolute on screen or relative to the coordinate system.
You can specify this on tab Basic of the Properties Dialog of the image.

You may specify up to three corner points of the image on tab Position of the Properties
Dialog. This gives you the flexibility to scale, rotate, and even distort images (also see
command Corner).

e (Corner 1: position of the lower left corner of the image
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e Corner 2: position of the lower right corner of the image
Note: This corner may only be set if Corner 1 was set before. It controls the width of
the image.

e Corner 4: position of the upper left corner of the image
Note: This corner may only be set if Corner 1 was set before. It controls the height of
the image.

Example: Create three points A, B, and C to explore the effects of the corner points.

e Set point A as the first and point B as the second corner of your image. By dragging
points A and Bin % Move mode you can explore their influence.

¢ Now, remove point B as the second corner of the image. Set point A as the first and
point C as the fourth corner and explore how dragging the points now influences the
image.

e Finally, you may set all three corner points and see how dragging the points distorts
your image.

Example: You already saw how to influence the position and size of your image. If you want
to attach your image to a point A and set its width to 3 and its height to 4 units, you could
do the following:

e SetCornerlton

e SetCorner2tonA + (3, 0)

e SetCorner4tonr + (0, 4)

Note: If you now drag point A in R Move mode, the size of your image does not change.

You may specify an image as a Background Image on tab Basic of the Properties Dialog. A

background image lies behind the coordinate axes and cannot be selected with the mouse
any more.

Note: In order to change the background setting of an image, you may open the Properties
Dialog by selecting [a] Properties... from the Edit menu.

The Transparency of an image can be changed in order to see objects or axes that lie behind

the image. You can set the transparency of an image by specifying a Filling value between 0
% and 100 % on tab Style of the Properties Dialog.
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3. Algebraic Input

3.1. General Notes

The algebraic representations of mathematical objects (e. g., values, coordinates, equations)
are shown in the Algebra View. You can create and modify objects by using the Input Bar at
the bottom of the GeoGebra window (see sections Direct Inputand and Commands).

Note: Always press the Enter-key after typing algebraic input into the Input Bar.

Note: Pressing the Enter-key at any time toggles the focus between the Input Bar and the
Graphics View. This allows you to enter expressions and commands into the Input Bar
without having to click on it with the mouse first.

Naming Objects

You can assign a certain name to an object when you create it using the /nput Bar:

e Points: In GeoGebra, points are always named using upper case letters. Just type in
the name (e. g., A, P) and an equal sign in front of the coordinates or commands.
Examples: ¢ = (2, 4),P = (1; 180°),Complex = 2 + i

e Vectors: In order to distinguish between points and vectors, vectors need to have a
lower case name in GeoGebra. Again, type in the name (e. g., v, u) and an equal sign
in front of the coordinates or commands.

Examples:v = (1, 3),u = (3; 90°),complex = 1 - 2i

e Lines, circles, and conic sections: These objects can be named by typing in the name
and a colon in front of their equations or commands.
Examples:g: y = x + 3,c: (x-1)"2 + (y — 2)"2 = 4,
hyp: x"2 - y*2 = 2

e functions: You can name functions by typing, for example, £ (x) =or g(x)=in front
of the function’s equation or commands.

Examples:h(x) = 2 x + 4,g(x) = x*2,trig(x) = sin(x)

Note:
e If you don’t manually assign a name to an object, GeoGebra assigns the names of
new objects in alphabetical order.
e You can create indices within the names of objects by using an underscore. For
example A; is entered as A 1 and sagis entered as s {AB}.

Change Values

There are two ways of manipulating a free object’s value:
e Change the value of the object by entering its name and the new value in the Input
Bar (see section Direct Input).
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Example: If you want to change the value of an existing number a = 3, type
a = 5 into the Input Bar and press the Enter-key.

e Edit the algebraic representation: Activate tool % Move and double click on the
object in the Algebra View. This opens a text box where you can edit the object’s
value. Press the Enter-key to apply your changes.

Note: While free objects’ values can be changed directly, the values of dependent objects

can only be influenced by changing their parent objects or by redefining the dependent
object.

Display Input Bar History

After placing the cursor in the Input Bar you can use the ™ up and |, down arrow keys of
your keyboard in order to navigate through prior input step by step.

Note: Click on the little question mark ® to the left of the Input Bar in order to display the
help feature for the Input Bar.

Insert Name, Value, or Definition of an Object into the Input Bar

Insert the name of an object: Activate tool % Move and select the object whose name you
want to insert into the Input Bar. Then, press the F5 key on your keyboard.

Note: The name of the object is appended to any expression you typed into the Input Bar
before pressing the F5 key.

Insert the value of an object: There are two ways of inserting an object’s value (e. g., (1, 3),
3x — 5y = 12) into the Input Bar.
e Right click (Mac OS: Ctrl-click) on the object and select item [ Copy to Input Bar
from the appearing Context Menu.
e Activate tool % Move and select the object whose value you want to insert into the
Input Bar. Then, press the F4 key on your keyboard.
Note: The value of the object is appended to any expression you typed into the Input
Bar before pressing the F4 key.

Insert the definition of an object: There are two ways of inserting an object’s definition (e.
g., A= (4, 2), c=Circle[A, B]) into the Input Bar.
e Altclick on the object to insert the object’s definition and delete whatever input
might have been in the Input Bar before.
e Activate tool ¥ Move and select the object whose definition you want to insert into
the Input Bar. Then, press the F3 key on your keyboard.
Note: The definition of the object replaces any expression you typed into the /nput
Bar before pressing the F3 key.
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3.2. Direct Input

GeoGebra can work with numbers, angles, points, vectors, segments, lines, conic sections,
functions, and parametric curves. You can enter these objects into the /nput Bar by using
their coordinates or equations and pressing the Enter-key.

3.2.1. Numbers and Angles

Numbers

You can create numbers by using the Input Bar. If you only type in a number (e. g., 3),
GeoGebra assigns a lower case letter as the name of the number. If you want to give your
number a specific name, you can type in the name followed by an equal sign and the
number (e. g., create a decimal r by typinginr = 5.32).

Note: In GeoGebra, numbers and angles use a period (.) as a decimal point.

You can also use the constant it and the Euler constant e for expressions and calculations by
selecting them from the drop down menu next to the /nput Bar or by using keyboard
shortcuts.

Note: If the variable e is not used as a name of an existing object yet, GeoGebra will
recognize it as the Euler constant if you use it in new expressions.

Angles

Angles are entered in degree (°) or radians (rad). The constant mt is useful for radian values
and can also be entered as pi.
Note: You can enter a degree symbol (°) or the pi symbol (1) by using the following keyboard
shortcuts:

e Alt-O (Mac OS: Ctrl-0) for the degree symbol °

e Alt-P (Mac OS: Ctrl-P) for the pi symbol rt

Example: You can enter an angle a in degree (e. g., « = 60°) orin radians (e. g.,
o = pi/3).

Note: GeoGebra does all internal calculations in radians. The degree symbol (°) is nothing
but the constant 71/180 used to convert degree into radians.

Examples:
e If a=30isanumber, then o = a° converts number a to an angle a = 30°, without
changing its value.
e Ifyoutypeinb = o / °,theangle ais converted back to the number b = 30,
without changing its value.
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Sliders and Arrow Keys

Free numbers and angles can be displayed as sliders in the Graphics View (see tool
= Slider). Using the arrow keys, you may change the value of numbers and angles in the
Algebra View too (see section Manual Animation).

Limit Value to Interval

Free numbers and angles may be limited to an interval [min, max] by using tab Slider of the
Properties Dialog (see also tool == Slider).

Note: For dependent angles you can specify whether they may become reflex or not on tab
Basic of the Properties Dialog.

3.2.2. Points and Vectors

Points and vectors may be entered in Cartesian or polar coordinates (see section Numbers
and Angles).
Note: Upper case labels denote points whereas lower case labels refer to vectors.

Examples:
e To enter a point P or a vector v in Cartesian coordinates you mayuse P = (1, 0)
orv = (0, 5).
e In order to use polar coordinates typeinP = (1; 0°) orv = (5; 90°).

Note: You need to use a semicolon to separate the two coordinates. If you don’t type
in the degree symbol, GeoGebra will treat the angle as if entered in radians.

In GeoGebra, you can also do calculations with points and vectors.

Examples:
e You can create the midpoint M of two points A and B by entering
M = (A + B) / 2intothe Input Bar.

e You may calculate the length of a vector v using length = sqgrt (v * v)

3.2.3. Lines and Axes

Lines

You can enter a line as a linear equation in x and y or in parametric form into the /nput Bar.
In both cases previously defined variables (e. g. numbers, points, vectors) can be used within
the equation.

Note: You can enter a line’s name at the beginning of the input followed by a colon.

Examples:
e Typeing: 3x + 4y = 2 toenterline g as a linear equation.

o Define a parametert (e.g.,, t = 3) before entering line g in parametric form using
g: X = (-5, 5) + t (4, -3).
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e Define the parametersm = 2andb = -1.Then, you can enter the equation
h: y = m*x + btogetaline hiny-intercept-form.

Axes

The two coordinate axes are available in commands using the names xAxis and yAxis.
Example: The command Perpendicular[2, xAxis] constructsthe perpendicular line to
the x-axis through a given point A.

3.2.4. Conic Sections

You may enter a conic section as a quadratic equation in x and y. Prior defined variables (e.
g., numbers, points, vectors) can be used within the conic’s equation.

Note: The conic section’s name can be entered at the beginning of the input followed by a
colon.

Examples:
e Ellipse ell: ell: 9 x*2 + 16 y*2 = 144
e Hyperbola hyp: hyp: 9 x"2 — 16 y*2 = 144
e Parabola par: par: y*2 = 4 x
e Circle c1: cl: x*2 + y"2 = 25
e Circle c2: c2: (x - 5)"2 + (y + 2)%2 = 25

Note: If you define two parametersa = 4 andb = 3 in advance, you may enter for
example anellipseasell: b2 x"2 + a2 y"2 = a2 b"2.
3.2.5. Functions of x

To enter a function you can use previously defined variables (e. g. numbers, points, vectors)
as well as other functions.

Examples:
e Function f: f(x) = 3 x"3 - x"2
e Functiong: g(x) = tan(f(x))
e Nameless function: sin (3 x) + tan(x)

Note: All available pre-defined functions (e. g. sin, cos, tan) are described in section Pre-
defined Functions and Operations.

In GeoGebra you can also use commands to get for example, the Integral and Derivative of a
function.

Note: You can also use the commands £' (x) or £ (x),... in order to get the derivatives of a
previously defined function f(x).

Example: Define function fas £ (x) = 3 x*3 - x"2.Then, you can type in

g(x) = cos(f' (x + 2)) inorderto get function g.
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Furthermore, functions can be translated by a vector (see command Translate) and a free
function can be moved with the mouse by using tool % Move.

Limit Function to Interval

In order to limit a function to an interval [a, b], you can use the command Function.

3.2.6. Pre-defined Functions and Operations

To create numbers, coordinates, or equations (see section Direct Input) you may also use
the following pre-defined functions and operations.

Note: The pre-defined functions need to be entered using parentheses. You must not put a
space between the function name and the parentheses.

Operation / Function Input
Addition +
Subtraction -
Multiplication * or Space key
Scalar product * or Space key
Division
Exponentiation ~oor 2
Factorial !
Gamma function gamma ( )
Parentheses ()
x-coordinate x( )
y-coordinate y()
Absolute value abs ()
Sign sgn( )
Square root sqrt ( )
Cubic root cbrt ()
Random number between 0 and 1 | random( )
Exponential function exp( ) or e*
Logarithm (natural, to base e) In( ) or log( )
Logarithm to base 2 1d( )
Logarithm to base 10 lg ()
Cosine cos ()
Sine sin( )
Tangent tan( )
Arc cosine acos ( )
Arc sine asin( )
Arc tangent atan( )
Hyperbolic cosine cosh( )
Hyperbolic sine sinh( )
Hyperbolic tangent tanh ( )
Antihyperbolic cosine acosh ( )
Antihyperbolic sine asinh( )
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Operation / Function Input
Antihyperbolic tangent atanh ( )
Greatest integer less than or equal | floor ( )
Least integer greater than or equal | ceil ( )
Round round ( )

3.2.7. Boolean Variables and Operations

You can use the Boolean variables true and false in GeoGebra. Just type, for example,
a = trueorb = false into the Input Bar and press the Enter-key.

Check Box and Arrow Keys

Free Boolean variables can be displayed as check boxes in the Graphics View (see tool
B2 Check Box to Show/Hide objects). By using the arrow keys of your keyboard you may also
change Boolean variables in the Algebra View (see section Manual Animation).

Note: You may also use Boolean variables like numbers (value 0 or 1). This allows you to use
a checkbox as the dynamic speed of an animated slider allowing you to start and stop the
animation. In this case, the animation button is only shown in the Graphics View if there is
also an animated slider with static (i. e. non-dynamic) speed.

Operations

You can use the following operations for Boolean variables and conditions in GeoGebra by
either selecting them from the list next to the /nput Bar or by entering them using the
keyboard:

List Keyboard Example Object types
N ) numbers, points,
Equal = == a = bora== . .
lines, conics a, b
numbers, points,
Unequal # I= a#boral!=b |, .
lines, conics a, b
Less than < < a<b numbers a, b
Greater than > > a>b numbers a, b
Less or equal
q < <= a £bora <=b numbers a, b
than
Greater or
> >= a 2bora > b numbers a, b
equal than
And A && A bora && b Booleans a, b
Or \% | V bora || b Booleans a, b
Not - ! —aorla Boolean a
Parallel I allb linesa, b
Perpendicular 1 alb linesa, b
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3.2.8. List Objects and Operations

Using curly braces you can create a list of several objects (e. g. points, segments, circles).
Examples:
e I = {A, B, C} givesyou a list consisting of three prior defined points A, B, and C.
e L = {(0, 0), (1, 1), (2, 2)} produces a list that consists of the entered
points, as well as these nameless points.
Note: By default, the elements of this list are not shown in the Graphics View.

Compare Lists of Objects

You can compare two lists of objects by using the following syntax:

e Listl == List2: Checks if the two lists are equal and gives you true or false as a
result.

e Listl != List2:Checks if the two lists are not equal and gives you true or false as
a result.

Apply Pre-defined Operations and Functions to Lists

Note: If you apply operations and pre-defined functions to lists, you will always get a new
list as a result.

Addition and Subtraction examples:

e Listl + List2:Adds corresponding elements of two lists.
Note: The two lists need to be of the same length.

e List + Number:Addsthe number to every element of the list.

e Listl - List2:Subtractsthe elements of the second list from corresponding
elements of the first list.
Note: The lists need to be of the same length.

e List — Number: Subtracts the number from every element of the list.

Multiplication and Division examples:

e Listl * List2:Multiplies corresponding elements of two lists.
Note: The lists need to be of the same length. If the two lists are compatible
matrices, matrix multiplication is used.

e List * Number: Multiplies every list element with the number.

e Listl / List2:Divides elements of the first list by corresponding elements of the
second list.
Note: The two lists need to be of the same length.

e List / Number: Divides every list element by the number.

e Number / List:Divides the number by every element of the list.

Examples using functions:
e List”2:Squares every element of the list.
e sin(List):Applies the sine function to every element of the list.

37



3.2.9. Matrix Objects and Operations

GeoGebra also supports matrices, which are represented as a list of lists that contain the
rows of the matrix.

Example: In GeoGebra, {{1, 2, 3}, {4, 5, 6}, {7, 8, 9}} represents the matrix

~ AP
o U1 N

3
6.
9

Matrix Operations

Addition and subtraction examples:

e Matrixl + Matrix2:Adds the corresponding elements of two compatible
matrices.

e Matrixl - Matrix2:Subtracts the corresponding elements of two compatible
matrices.

Multiplication examples:

e Matrix * Number: Multiplies every element of the matrix by the given number.

e Matrixl * Matrix2:Uses matrix multiplication to calculate the resulting matrix.
Note: The rows of the first and columns of the second matrix need to have the same
number of elements.
Examgle: {{1, 2y, {3, 4}, {5, 6}y}y * {{1, 2, 3}, {4, 5, 6}} gives
you the matrix {{9, 12, 15}, {19, 26, 33}, {29, 40, 51}}.

e 2x2 Matrix * Point (or Vector): Multiplies the matrix with the given
point/vector and gives you a point as a result.
Example: {{1, 2}, {3, 4}} * (3, 4) givesyouthe pointA=(11, 25).

e 3x3 Matrix * Point (or Vector): Multiplies the matrix with the given
point/vector and gives you a point as a result.
Example: {{1, 2, 3}, {4, 5, 6}, {0, 0, 1}} * (1, 2) givesyouthe
point A = (8, 20).
Note: This is a special case for affine transformations where homogenous
coordinates are used: (x, y, 1) for a point and (x, y, 0) for a vector. This example is
therefore equivalent to:
({1, 2, 3}, {4, 5, 6}, {0, 0, 1}} * {1, 2, 1}.

Other examples (see also section Matrix Commands):
e Determinant [Matrix]: Calculates the determinant for the given matrix.
e Invert[Matrix]:Invertsthe given matrix

e Transpose[Matrix]: Transposes the given matrix

3.2.10. Complex Numbers and Operations

GeoGebra does not support complex numbers directly, but you may use points to simulate
operations with complex numbers.
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Example: If you enter the complex number 3 + 41i into the /nput Bar, you get the point
(3, 4) in the Graphics View. This point’s coordinates are shown as 3 + 4i in the Algebra View.

Note: You can display any point as a complex number in the Algebra View. Open the
Properties Dialog for the point and select Complex Number from the list of Coordinates
formats on tab Algebra.

If the variable i has not already been defined, it is recognized as the ordered pairi=(0, 1) or
the complex number 0 + 1i. This also means, that you can use this variable i in order to type
complex numbers into the Input Bar (e. g., g = 3 + 4i).

Addition and subtraction examples:
e (2 + 1i) + (1 - 2i) gives you the complex number 3 - 1i.
e (2 + 1i) - (1 - 21i) givesyou the complex number 1 + 3i.

Multiplication and division examples:

e (2 + 1i) * (1 - 21i) givesyou the complex number 4 — 3i.

e (2 + 1i) / (1 - 2i) givesyou the complex number 0 + 1i.
Note: The usual multiplication (2, 1)* (1, -2) givesyou the scalar product of the two
vectors.

Other examples:
GeoGebra also recognizes expressions involving real and complex numbers.

e 3 + (4 + 5i) givesyouthe complex number 7 + 5i.
e 3 - (4 + 5i) givesyouthe complex number -1 - 5i.
e 3 / (0 + 1i) givesyouthe complex number 0 - 3i.
e 3 * (1 + 2i) givesyouthe complex number 3 + 6i.

3.3. Commands

Using commands you can produce new and modify existing objects.

Note: A command's result may be named by entering a label followed by an equal sign (=).
In the example below, the new point is named S.

Example: To get the intersection point of two lines g and h you can enter

S = Intersect[qg, h] (see command Intersect).

Note: You can also use indices within the names of objects: A; is entered as 2 1 while Spg is
created using s {AB}.

Automatic Completion of Commands

When you type a command into GeoGebra’s Input Bar, the software tries to automatically
complete the command for you. This means that after you typed in the first two letters of
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the command into the /Input Bar, GeoGebra displays the first command of an alphabetically
sorted list that starts with these letters.
e In order to accept this suggestion and place the cursor in between the brackets, hit
the Enter-key.
o If the suggested command is not the one you wanted to type in, just keep typing.
GeoGebra will adapt its suggestions to the letters you enter.

3.3.1. General Commands

ConstructionStep

ConstructionStep[]: Returns the current Construction Protocol step as a number.
ConstructionStep[Object]: Returns the Construction Protocol step for the given object
as a number.

Delete

Delete[Object]: Deletes the object and all its dependents objects.

Note: Also see tool i/ Delete Object

Relation

Relation[Object a, Object b]:Showsa message box that gives you information
about the relation of object a and object b.
Note: This command allows you to find out whether two objects are equal, if a point
lies on a line or conic, or if a line is tangent or a passing line to a conic.

Note: Also see tool =2+ Relation

3.3.2. Boolean Commands

If

If[Condition, Object]: Yields a copy of the object if the condition evaluates to true,
and an undefined object if it evaluates to false.

If[Condition, Object a, Object b]: Yields a copy of object a if the condition
evaluates to true, and a copy of object b if it evaluates to false.

IsDefined

IsDefined[Object]: Returns true or false depending on whether the object is defined or
not.
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Isinteger

IsInteger [Number]: Returns true or false depending whether the number is an integer
or not.

3.3.3. Number Commands

AffineRatio

AffineRatio[Point A, Point B, Point C]:Returns the affine ratio A of three
collinear points A, B, and C, where C=A +A * AB.

Area

Area[Point A, Point B, Point C, ...]:Calculatesthe area of the polygon defined
by the given points A, B, C,...
Area[Conic c]: Calculates the area of a conic section c (circle or ellipse).

Note:
e Inorder to calculate the area between two function graphs, you need to use the
command Integral.
e Also see tool ™ Area

AxisStep

AxisStepX[]: Returns the current step width for the x-axis.
AxisStepY[]: Returns the current step width for the y-axis.

Note: Together with the Corner and Sequence commands, the AxisStep commands allow you
to create custom axes (also see section Customizing Coordinate Axes and Grid).

BinomialCoefficient

BinomialCoefficient [Number n, Number r]: Calculates the binomial coefficient
n choose r.

Circumference

Circumference[Conic]: Returns the circumference of a circle or ellipse.

CrossRatio

CrossRatio[Point A, Point B, Point C, Point D]: Calculates the cross ratio A
of four collinear points A, B, C, and D, where
A = AffineRatio[B, C, D] / AffineRatio[A, C, D].
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Curvature

Curvature [Point, Function]: Calculates the curvature of the function in the given
point.
Curvature[Point, Curve]: Calculates the curvature of the curve in the given point.

Distance

Distance[Point A, Point B]: Yields the distance of two points A and B.
Distance[Point, Line]: Yields the distance of the point and the line.
Distance[Line g, Line h]: Yields the distance of the parallel lines g and h.
Note: The distance of intersecting lines is 0. Thus, this command is only interesting
for parallel lines.

Note: Also see tool -~ Distance or Length

GCD
UK English: HCF

GCD[Number a, Number b]: Calculates the greatest common divisor of numbers a and b
(UK-English: HCF = highest common factor).

GCD[List of Numbers]: Calculates the greatest common divisor of the list of numbers
(UK-English: HCF = highest common factor).

Integer Division

Div[Number a, Number b]: Calculates the integer quotient for division of number a by
number b.

Integral

Integral [Function, Number a, Number b]:Returns the definite integral of the
function in the interval [a, b].
Note: This command also draws the area between the function graph of f and the x-
axis.

Integral [Function f, Function g, Number a, Number b]: Yields the definite
integral of the difference f(x) - g(x) in the interval [a, b].
Note: This command also draws the area between the function graphs of fand g.

Note: Also see command for Indefinite Integral

Iteration

Iteration[Function, Number x0, Number n]: Iterates the function n times using
the given start value x0.
Example: After defining £ (x) = x"2the command Iteration[f, 3, 2] gives
you the result (3%)% = 81.
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LCM

LCM[Number a, Number b]: Calculates the least common multiple of two numbers a
and b (UK English: LCM = lowest common multiple).

LCM[List of numbers]: Calculates the least common multiple of the elements of the list
(UK English: LCM = lowest common multiple).

Length

Length [Vector]: Yields the length of the vector.

Length[Point A]: Yields the length of the position vector of the given point .

Length[Function, Number x1, Number x2]:Yieldsthe length of the function graph
in the interval [x1, x2].

Length[Function, Point A, Point B]: Yields the length of the function graph
between the two points A and B.
Note: If the given points do not lie on the function graph, their x-coordinates are
used to determine the interval.

Length[Curve, Number tl, Number t2]:Yieldsthe length of the curve between the
parameter values t1 and t2.

Length[Curve c, Point A, Point B]: Yields the length of curve c between two
points A and B that lie on the curve.

Length [List]: Yields the length of the list which is the number of elements in the list.

Note: Also see tool -~ Distance or Length

LinearEccentricity

LinearEccentricity[Conic]: Calculates the linear eccentricity of the conic section.
Note: The linear eccentricity is the distance between a conic's center and its focus, or
one of its two foci.

LowerSum

LowerSum[Function, Number a, Number b, Number n]: Yields the lower sum of
the given function on the interval [a, b] with n rectangles.
Note: This command draws the rectangles for the lower sum as well.

Minimum and Maximum

Min [Number a, Number b]: Yields the minimum of the given numbers a and b.
Max [Number a, Number b]: Yields the maximum of the given numbers a and b.

Modulo Function

Mod[Integer a, Integer b]:Yields the remainder when integer a is divided by integer
b.
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Parameter

Parameter [Parabola]: Returns the parameter of the parabola, which is the distance of
directrix and focus.

Perimeter

Perimeter [Polygon]: Returns the perimeter of the polygon.

Radius

Radius[Circle]: Returns the radius of the circle.

Random commands

RandomBetween[Min Integer, Max Integer]:Generatesarandom integer between
min and max (inclusive).

RandomBinomial [Number n of Trials, Probability p]:Generatesarandom
number from a binomial distribution with n trials and probability p.

RandomNormal [Mean, Standard Deviation]: Generates a random number from a
normal distribution with given mean and standard deviation.

RandomPoisson [Mean]: Generates a random number from a Poisson distribution with
given mean.

SemiMajorAxisLength

SemiMajorAxisLength[Conic]: Returns the length of the semimajor axis (half of the
major axis) of the conic section.

SemiMinorAxisLength

SemiMinorAxisLength[Conic]: Returns the length of the semiminor axis (half of the
minor axis) of the conic section.

Slope

Slope [Line]: Returns the slope of the given line.
Note: This command also draws the slope triangle whose size may be changed on tab
Style of the Properties Dialog.

Note: Also see tool -~ Slope

TrapezoidalSum
UK English: TrapeziumSum
TrapezoidalSum[Function, Number a, Number b, Number n]: Calculates the

trapezoidal sum of the function in the interval [a, b] using n trapezoids.
Note: This command draws the trapezoids of the trapezoidal sum as well.
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UpperSum

UpperSum|[Function, Number a, Number b, Number n]:Calculatesthe upper sum
of the function on the interval [a, b] using n rectangles.
Note: This command draws the rectangles of the upper sum as well.

3.3.4. Angle Command

Angle

Angle[Vector vl, Vector wv2]:Returnsthe angle between two vectors vl and v2
(between 0 and 360°) .

Angle[Line g, Line h]:Returnsthe angle between the direction vectors of two lines g
and h (between 0 and 360°) .

Angle[Point A, Point B, Point C]:Returns the angle enclosed by BA and BC
(between 0 and 360°), where point B is the apex.

Angle[Point A, Point B, Angle a]:Returns the angle of size a drawn from point A
with apex B.
Note: The point Rotate[A, a, B] is created as well.

Angle[Conic]: Returns the angle of twist of a conic section’s major axis (see command
Axes) .

Angle [Vector]: Returns the angle between the x-axis and given vector.

Angle[Point]: Returns the angle between the x-axis and the position vector of the given
point.

Angle [Number]: Converts the number into an angle (result between 0 and 2pi).

Angle[Polygon]: Creates all angles of a polygon in mathematically positive orientation (i.
e., counter clockwise).
Note: If the polygon was created in counter clockwise orientation, you get the
interior angles. If the polygon was created in clockwise orientation, you get the
exterior angles.

Note: Also see tools < Angle and <% Angle with Given Size

3.3.5. Point Commands

Center

UK English: Centre

Center [Conic]: Returns the center of a circle, ellipse, or hyperbola.

Note: Also see tool " Midpoint or Center

Centroid

Centroid[Polygon]: Returns the centroid of the polygon.
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Corner

Corner [Number n of Corner]: Creates a point at the corner of the Graphics View
(n =1, 2, 3, 4) which is never visible on screen.

Corner[Image, Number n of Corner]:Creates a point at the corner of the image
(n=1,2 3, 4).

Corner [Text, Number n of Corner]: Creates a point at the corner of the text
(n=1,2, 3, 4).

Note: The numbering of the corners is counter-clockwise and starts at the lower left corner.

Extremum

UK English: TurningPoint

Extremum[Polynomiall: Yields all local extrema of the polynomial function as points on
the function graph.

Focus

Focus [Conic]: Yields (all) foci of the conic section.

InflectionPoint

InflectionPoint[Polynomial]: Yields all inflection points of the polynomial as points
on the function graph.

Intersect

Intersect[Line g, Line h]: Yields the intersection point of lines g and h.

Intersect[Line, Conic]: Yields all intersection points of the line and conic section
(max. 2).

Intersect[Line, Conic, Number n]:Yieldsthe n intersection point of the line and
the conic section.

Intersect[Conic cl, Conic c2]: Yields all intersection points of conic sections c1
and c2 (max. 4).

Intersect[Conic cl, Conic c¢2, Number n]:Yieldsthe n'™ intersection point of
conic sections c1 and c2.

Intersect[Polynomial f1, Polynomial £2]: Yields all intersection points of
polynomials f1 and f2.

Intersect[Polynomial f1, Polynomial £2, Number n]: Yields the nth
intersection point of polynomials f1 and f2.

Intersect [Polynomial, Line]: Yields all intersection points of the polynomial and the
line.

Intersect[Polynomial, Line, Number n]: Yieldsthe n" intersection point of the
polynomial and the line.

Intersect[Function f, Function g, Point A]: Calculates the intersection point
of functions f and g by using Newton's method with initial point A.

Intersect[Function, Line, Point A]: Calculates the intersection point of the
function and the line by using Newton's method with initial point A.
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Note: Also see tool = Intersect two Objects

Midpoint

Midpoint [Point A, Point B]:Returnsthe midpoint of points A and B.
Midpoint [Segment]: Returns the midpoint of the segment.

Note: Also see tool =" Midpoint or Center

Point

Point [Line]: Returns a point on the line.

Conic]: Returns a point on the conic section.
Function]: Returns a point on the function.
Polygon]: Returns a point on the polygon.
Vector ]:Returns a point on the vector.

Point, Vector]:Createsa new point by adding the vector to the given point.

Point
Point
Point
Point

— — o/ o/ o/

Point

Note: Also see tool ** New Point

Root

Root [Polynomiall]: Yields all roots of the polynomial as intersection points of the
function graph and the x-axis.

Root [Function, Number a]: Yields one root of the function using the initial value a for
Newton's method.

Root [Function, Number a, Number b]: Yields one root of the function in the interval
[a, b] (regula falsi).

Vertex

Vertex[Conic]: Returns (all) vertices of the conic section.

3.3.6. Vector Commands

CurvatureVector

CurvatureVector [Point, Function]: Yieldsthe curvature vector of the function in
the given point.

CurvatureVector [Point, Curve]: Yields the curvature vector of the curve in the given
point.

Direction

Direction[Line]: Yields the direction vector of the line.
Note: A line with equation ax + by = ¢ has the direction vector (b, - a).
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PerpendicularVector

PerpendicularVector [Line]: Returns the perpendicular vector of the line.
Note: A line with equation ax + by = ¢ has the perpendicular vector (a, b).
PerpendicularVector [Vector v]:Returnsthe perpendicular vector of the given
vector.
Note: A vector with coordinates (a, b) has the perpendicular vector (-b, a).

UnitPerpendicularVector

UnitPerpendicularVector [Line]: Returns the perpendicular vector with length 1 of
the given line.

UnitPerpendicularVector [Vector]: Returns the perpendicular vector with length 1
of the given vector.

UnitVector

UnitVector [Line]: Yields the direction vector with length 1 of the given line.
UnitVector [Vector]: Yields a vector with length 1, which has the same direction and
orientation as the given vector.

Vector

Vector[Point A, Point B]: Creates a vector from point A to point B.
Vector [Point]: Returns the position vector of the given point.

Note: Also see tool <~ Vector between Two Points

3.3.7. Segment Command

Segment

Segment [Point A, Point B]: Creates a segment between two points A and B.
Segment [Point A, Number a]:Createsasegment with length a and starting point A.
Note: The endpoint of the segment is created as well.

Note: Also see tools «* Segment between Two Points and «* Segment with Given Length
from Point

3.3.8. Ray Command

Ray

Ray[Point A, Point B]: Creates a ray starting at point A through point B.
Ray[Point, Vector v]:Creates a ray starting at the given point which has the direction
vector v.

Note: Also see tool «* Ray through Two Points
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3.3.9. Polygon Command

Polygon

Polygon[Point A, Point B, Point C,...]:Returns a polygon defined by the given
points A, B, C,...

Polygon[Point A, Point B, Number n]:Creates aregular polygon with n vertices
(including points A and B).

[N
|

Note: Also see tools ** Polygon and * Regular Polygon

3.3.10. Line Commands

AngleBisector

AngleBisector[Point A, Point B, Point C]:Returnsthe angle bisector of the
angle defined by points A, B, and C.
Note: Point B is apex of this angle.

AngleBisector[Line g, Line h]:Returns both angle bisectors of the lines.

Note: Also see tool <= Angle Bisector

Asymptote

Asymptote [Hyperbolal]: Yields both asymptotes of the hyperbola.

Axes

Axes [Conic]: Returns the major and minor axis of a conic section.

ConjugateDiameter

ConjugateDiameter[Line, Conic]: Returns the conjugate diameter of the diameter
that is parallel to the line (relative to the conic section).

ConjugateDiameter[Vector, Conic]:Returnsthe conjugate diameter of the diameter
that is parallel to the vector (relative to the conic section).

Directrix

Directrix[Parabolal]: Yields the directrix of the parabola.

Line

Line[Point A, Point B]:Creates a line through two points A and B.

Line[Point, Parallel Line]: Creates aline through the given point parallel to the
given line.

Line[Point, Direction Vector v]:Creates a line through the given point with
direction vector v.

49



Note: Also see tool = Line through Two Points

MajorAxis

MajorAxis[Conic]: Returns the major axis of the conic section.

MinorAxis

MinorAxis [Conic]: Returns the minor axis of the conic section.

PerpendicularLine

PerpendicularLine[Point, Line]: Creates a line through the point perpendicular to
the given line.

PerpendicularLine[Point, Vector]: Creates a line through the point perpendicular
to the given vector.

Note: Also see tool -~ Perpendicular Line

PerpendicularBisector

PerpendicularBisector[Point A, Point B]: Yields the perpendicular bisector of
the line segment AB.
PerpendicularBisector[Segment]: Yields the perpendicular bisector of the segment.

Note: Also see tool Perpendicular Bisector

Polar

Polar[Point, Conic]: Creates the polar line of the given point relative to the conic
section.

Note: Also see tool -© Polar or Diameter Line

Tangent

Tangent [Point, Conic]: Creates (all) tangents through the point to the conic section.
Tangent [Line, Conic]: Creates (all) tangents to the conic section that are parallel to
the given line.
Tangent [Number a, Function]: Creates the tangent to the function at x = a.
Tangent [Point A, Function]: Creates the tangent to the function at x = x(A).
Note: x(A) is the x-coordinate of point A.
Tangent [Point, Curvel]: Creates the tangent to the curve in the given point.

Note: Also see tool £ Tangents
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3.3.11. Conic Section Commands

Circle

Circle[Point M, Number r]:Yields a circle with midpoint M and radius r.

Circle[Point M, Segment]: Yields a circle with midpoint M whose radius is equal to
the length of the given segment.

Circle[Point M, Point A]: Yields a circle with midpoint M through point A.

Circle[Point A, Point B, Point C]: Yields a circle through the given points A, B
and C.

Note: Also see tools % Compass, © Circle with Center through Point, @ Circle with Center
and Radius, and Q Circle through Three Points

Conic

Conic[Point A, Point B, Point C, Point D, Point E]:Returns a conic section
through the five given points A, B, C, D, and E.
Note: If four of the points lie on one line the conic section is not defined.

Note: Also see tool <3 Conic through Five Points

Ellipse

Ellipse[Point F, Point G, Number a]: Creates an ellipse with focal points Fand G
and semimajor axis length a.
Note: Condition: 2a > Distance[F, G]

Ellipse[Point F, Point G, Segment]: Creates an ellipse with focal points Fand G
where the length of the semimajor axis equals the length of the given segment.

Ellipse[Point F, Point G, Point A]:Creates an ellipse with foci Fand G passing
through point A.

Note: Also see tool &’ Ellipse

Hyperbola

Hyperbola[Point F, Point G, Number a]: Createsa hyperbola with focal points F
and G and semimajor axis length a.
Note: Condition: 0 < 2a < Distance[F, G]

Hyperbola[Point F, Point G, Segment]: Creates a hyperbola with focal points F.
and G where the length of the semimajor axis equals the length of segment s.

Hyperbola[Point F, Point G, Point A]:Creates a hyperbola with foci Fand G
passing through point A.

Note: Also see tool *+ Hyperbola
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OsculatingCircle

OsculatingCircle[Point, Function]: Yields the osculating circle of the function in
the given point.

OsculatingCircle[Point, Curve]: Yields the osculating circle of the curve in the
given point.

Parabola

Parabola[Point F, Line g]: Returns a parabola with focal point F and directrix g.

Note: Also see tool NS Parabola

3.3.12. Function Commands

Conditional Functions

You can use the Boolean command /f in order to create a conditional function.
Note: You can use derivatives and integrals of such functions and intersect conditional

functions like “normal” functions.
Examples:
e f(x) = If[x < 3, sin(x), x"2] givesyou a function that equals sin(x) for

x < 3 and x° for x > 3.

2

e a £ 3 A b 2 0testswhether “a equals 3 and b is greater than or equal to 0”.

Note: Symbols for conditional statements (e. g., =, A, 2) can be found in the list next to the
right of the Input Bar.

Derivative

Derivative [Function]: Returns the derivative of the function.
Derivative [Function, Number n]:Returnsthe n'" derivative of the function.

Note: You can use f' (x) instead of Derivative [f]as well as £" (x) instead of
Derivative[f, 2] andso on.

Expand

Expand[Function]: Multiplies out the brackets of the expression.
Example: Expand[ (x + 3) (x - 4)] givesyou f(x) =x’-x-12

Factor

UK English: Factorise

Factor [Polynomial]: Factors the polynomial.
Example: Factor[x"2 + x - 6] givesyou f(x) = (x-2)(x+3)
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Function

Function[Function, Number a, Number b]: Yields a function graph, that is equal to
fontheinterval [a, b] and not defined outside of [a, b].
Note: This command should be used only in order to display functions in a certain interval.

Example: £ (x) = Function[x"2, -1, 1] givesyou the graph of function X% in the
interval [-1, 1]. If you then type in g (x) = 2 £ (x) you will get the function g(x) = 2 X%, but
this function is not restricted to the interval [-1, 1].

Integral

Integral [Function]: Yields the indefinite integral for the given function.

Note: Also see command for Definite integral

Polynomial

Polynomial [Function]: Yields the expanded polynomial function.
Example: Polynomial [ (x - 3)A2]WeHSX2-6X+9.

Polynomial [List of n points]: Creates the interpolation polynomial of degree n-1
through the given n points.

Simplify

Simplify[Function]: Simplifies the terms of the given function if possible.
Examples:

e Simplify[x + x + x] givesyou a function f(x) = 3x.

e Simplifyl[sin(x) / cos(x)] givesyou a function f(x) = tan(x).

e Simplify[-2 sin(x) cos (x)] givesyou a function f(x) = sin(-2 x).

TaylorPolynomial

TaylorPolynomial [Function, Number a, Number n]:Createsthe power series
expansion for the given function about the point x = a to order n.

3.3.13. Parametric Curve Command

Curve

Curve[Expression el, Expression e2, Parameter t, Number a, Number
b]: Yields the Cartesian parametric curve for the given x-expression el and y-
expression e2 (using parameter t) within the given interval [a, b].

Example: Input of ¢ = Curve([2 cos(t), 2 sin(t), t, 0, 2 pi] createsa
circle with radius 2 around the origin of the coordinate system.

Note: Parametric curves can be used with pre-defined functions and arithmetic operations.
Example: Input c (3) returns the point at parameter position 3 on curve c.
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Note: Using the mouse you can also place a point on a curve using tool ** New Point or
command Point. Since the parameters a and b are dynamic you could use slider variables as
well (see tool == Slider).

Commands for Parametric Curves

Curvature [Point, Curve]: Calculates the curvature of the curve in the given point.

CurvatureVector [Point, Curve]: Yields the curvature vector of the curve in the given
point.

Derivative [Curve]: Returns the derivative of the parametric curve.

Derivative [Curve, Number n]:Returnsthe n” derivative of the parametric curve.

Length[Curve, Number tl, Number t2]:Yieldsthe length of the curve between the
parameter values t1 and t2.

Length[Curve ¢, Point A, Point B]: Yields the length of curve c between two
points A and B that lie on the curve.

OsculatingCircle[Point, Curve]: Yields the osculating circle of the curve in the
given point.

Tangent [Point, Curve]: Creates the tangent to the curve in the given point.

3.3.14. Arc and Sector Commands

Note: The algebraic value of an arc is its length and the value of a sector is its area.

Arc

Arc[Conic, Point A, Point B]:Returns a conic section arc between two points A
and B on the conic section c.
Note: This only works for a circle or ellipse.
Arc[Conic, Number tl, Number t2]:Returnsa conic section arc between two
parameter values t1 and t2 on the conic section.
Note: Internally the following parameter forms are used:
e (Circle: (r cos(t), r sin(t)) where r is the circle's radius.
e FEllipse: (a cos(t), b sin(t)) where a and b are the lengths of the semimajor and
semiminor axis.

CircularArc

CircularArc[Point M, Point A, Point B]: Creates a circular arc with midpoint M
between points A and B.
Note: Point B does not have to lie on the arc.

Note: Also see tool *} Circular Arc with Center between Two Points

CircularSector

CircularSector[Point M, Point A, Point B]: Creates a circular sector with
midpoint M between two points A and B.
Note: Point B does not have to lie on the arc of the sector.
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Note: Also see tool &4 Circular Sector with Center between Two Points

CircumcircularArc

CircumcircularArc[Point A, Point B, Point C]: Creates a circular arc through
three points A, B, and C, where A is the starting point and Cis the endpoint of the
circumcircular arc.

Note: Also see tool “7 Circumcircular Arc through Three Points

CircumcircularSector

CircumcircularSector[Point A, Point B, Point C]: Creates a circular sector
whose arc runs through the three points A, B, and C. Point A is the starting point and
point Cis the endpoint of the arc.

Note: Also see tool “V Circumcircular Sector through Three Points

Sector

Sector[Conic, Point A, Point B]: Yields a conic section sector between two points
A and B on the conic section.
Note: This works only for a circle or ellipse.
Sector[Conic, Number tl, Number t2]: Yields a conic section sector between two
parameter values t1 and t2 on the conic section.
Note: Internally the following parameter forms are used:
e (Circle: (r cos(t), r sin(t)) where ris the circle's radius.
e FEllipse: (a cos(t), b sin(t)) where a and b are the lengths of the semimajor and
semiminor axis.

Semicircle

Semicircle[Point A, Point B]: Creates a semicircle above the segment AB.

Note: Also see tool ¢ * Semicircle

3.3.15. Text Commands

FormulaText

FormulaText [Object]: Returns the formula for the object as a LaTeX text.

Example: If a = 2 and f{x) = a X, then FormulaText [ £] returns 2 x° (as a LaTeX
text).

FormulaText [Object, Boolean]:Returnsthe formula for the object as LaTeX text. The
Boolean variable determines if values are substituted for variables (true) or if
variable names are shown in the text (false).

Examples: If a = 2 and f(x) = a X°, then
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FormulaText [f, true] returns2x’(asa LaTeX text).
FormulaText [f, false] returnsax’ (asa LaTeX text).

FractionText

FractionText [Number]: Converts the number to a fraction, which is displayed as a
(LaTeX) text object in the Graphics View.
Example: Ifa:y=1.5x+ 2is aline, then FractionText [Slope[a]] gives you the
fraction 3/2 as a text.

LetterToUnicode

LetterToUnicode ["Letter"]: Turns a single letter into its Unicode number
Note: The letter needs to be in between a set of quotation marks.
Example: LetterToUnicode["a"] returns the number 97

Name

Name [Object]: Returns the name of an object as a text in the Graphics View.
Note: Use this command in dynamic text for objects that might be renamed. The
Name command is the opposite of the Object command.

Object

Object [Name of Object as Text]:Returnsthe object for a given name. The result is
always a dependent object.
Note: The Object command is the opposite of the Name command.
Example: If points A1, A2, ..., A20 exist and slider n = 2, then Object ["A" + n]
gives you a copy of point A2.

TableText

TableText[List 1, List 2, List 3,...]:Creates atextthat contains a table of
the list objects.
Note: By default, every list is displayed in a new column of the table.
Examples:
e TableText[{x"2, 4}, {x*3, 8}, {x™4, 16}]
creates a table as a text object with three rows and two columns. All items of
the table are left aligned.
e TableText[Sequencel[i”2, i, 1, 10]]
creates a table as a text object with one row. All items of the table are left
aligned.

TableText[List 1, List 2, List 3,..., "Alignment of text"]:Createsa
text that contains a table of the list objects. The optional text “Alignment of text”
controls the orientation and alignment of the table text.

Note: Possible values are "vI", "vc", "vr", "v", "h", "hl", "hc", "hr". Default is "hl".
e "v'"=vertical,i. e. lists are columns
e "h" =horizontal, i. e. lists are rows
"I'" = left aligned
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e "r"=rightaligned
e 'c"=centered
Examples:

e TableText[{1,2,3,4},{1,4,9,16},"v"]
creates a text with two columns and four rows whose elements are left
aligned.

e TableText[{1,2,3,4},{1,4,9,16},"h"]
creates a text with two rows and four columns whose elements are left
aligned.

e TableText[{11.2,123.1,32423.9,"234.0"},"vr"
creates a text with one column whose elements are right aligned.

Text

Text [Object]: Returns the formula for the object as a text object.
Note: By default, values are substituted for variables.

Example: Ifa=2andc= aZ, then Text [c] returns the text "4".

Text [Object, Boolean]: Returnsthe formula for the object as a text object. The
Boolean variable determines if values are substituted for variables (true) or if
variable names are shown in the text (false).

Example: Ifa=2andc = d’, then

Text[c, true] returnsthe text "4".

Text [c, false] returns the text "a*".

Text [Object, Point]:Returnsthe formula for the object as a text object at the position
of the given point.

Example: Text ["hello", (2, 3)] draws the text at the position (2, 3).

Text [Object, Point, Boolean]:Returnsthe formula for the object as a text object at
the position of the given point. The Boolean variable determines if values are
substituted for variables (true) or if variable names are shown in the text (false).

TextToUnicode

TextToUnicode ["Text"]: Turns the text into a list of Unicode numbers, one for each
character.
Examples:
e TextToUnicode["Some text"] gives you the list of Unicode numbers
{83, 111, 109, 101, 32, 116, 101, 120, 116}.
o |Iftextlis "hello", then TextToUnicode [text1] gives you the list of
Unicode numbers {104, 101, 108, 108, 111}.

UnicodeToletter

UnicodeToLetter[Integer]: Converts the integer Unicode number back into a letter
which is displayed as a text object in the Graphics View.
Example: UnicodeToLetter [97] gives you the text "a".
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UnicodeToText

UnicodeToText [List of Integers]: Converts the integer Unicode numbers back into
text.
Example: UnicodeToText [{104, 101, 108, 108, 111}] givesyou the text
"hello".

3.3.16. Locus Command

Locus

Locus [Point Q, Point P]:Returnsthe locus line of point Q which depends on point P.
Note: Point P has to be a point on an object (e. g. line, segment, circle).

Note: Also see tool & Locus

3.3.17. List and Sequence Commands

Append

Append[List, Object]:Appends the object to the list.
Example: Append[{1, 2, 3}, 4] givesyouf{l, 2, 3, 4}.

Append [Object, List]:Appends the list to the object.
Example: Append[4, {1, 2, 3}] givesyou{4, 1,2, 3}.

Countlf

CountIf[Condition, List]:Countsthe number of elements in the list satisfying the
condition.
Examples:
e CountIf[x < 3, {1, 2, 3, 4, 5}] givesyouthe number 2.
e CountIf[x<3, Al:A10] where A1:A10is a range of cells in the
spreadsheet, counts all cells whose values are less than 3.

Element

Element [List, Number n]:Yieldsthe n element of the list.
Note: The list can contain only elements of one object type (e. g., only numbers or
only points).

First

First[List]: Returns the first element of the list.
First[List, Number n of elements]:Returnsa new list that contains just the first n
elements of the list.
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Insert

Insert[Object, List, Position]:Insertsthe objectin the list at the given position.
Example: Insert [x~2, {1, 2, 3, 4, 5}, 3] pIacestat the third position
and gives you the list {1, 2, X’ 3,4, 5}
Note: If the position is a negative number, then the position is counted from the
right.
Example: Insert [x"2, {1, 2, 3, 4, 5}, -1] pIacesx2 at the end of the list
and gives you thelist {1, 2, 3, 4, 5, )(2}.

Insert[List 1, List 2, Position]:Inserts all elements of list1 in list2 at the given
position.
Example: Insert {11, 12}, {1, 2, 3, 4, 5}, 3] placesthe elements of
list1 at the third (and following) position(s) of list2 and gives you the list
{1,2,11, 12, 3, 4, 5}.
Note: If the position is a negative number, then the position is counted from the
right.
Example: Insert[{11, 12}, {1, 2, 3, 4, 5}, -2] placesthe elements of
list1 at the end of list2 before its last element and gives you {1, 2, 3, 4, 11, 12, 5}.

Intersection

Intersection[List 1, List 2]:Givesyou a new list containing all elements that are
part of both lists.

IterationList

IterationList [Function, Number x0, Number n]:
Gives you a list of length n+1 whose elements are iterations of the function starting
with the value x0.
Example: After defining function £ (x) = x~2 the command
L = IterationList[f, 3, 2] givesyouthelistlL={3,9, 81}.

Join

Join[List 1, List 2, ...]:Joinsthetwo (or more) lists.
Note: The new list contains all elements of the initial lists even if they are the same.
The elements of the new list are not re-ordered.
Example: Join[{5, 4, 3}, {1, 2, 3}] createsthelist{5, 4 3,1, 2, 3}.
Join[List of lists]:Joinsthe sub-lists into one longer list.
Note: The new list contains all elements of the initial lists even if they are the same.
The elements of the new list are not re-ordered.
Examples:
e Join[{{1, 2}}] createsthe list{1, 2}.
e Join[{{1, 2, 3}, {3, 4}, {8, 7}}] createsthe list
{1,2,3,3,4,8 7}
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Keeplf

KeepIf[Condition, List]: Createsa new list that only contains those elements of the
initial list that fulfill the condition.
Example: KeepIf[x<3, {1, 2, 3, 4, 1, 5, 6}] returnsthe newlist{1, 2, 1}.

Last

Last [List]: Returns the last element of the list.
Last[List, Number n of Elements]:Returns a list containing just the last n elements
of the list.

Length

Length [List]: Yields the length of the list, which is the number of list elements.

Min

Min [List]: Returns the minimal element of the list.

Max

Max [List]: Returns the maximal element of the list.

Product

Product [List of Numbers]: Calculates the product of all numbers in the list.

RemoveUndefined

RemoveUndefined[List]: Removes undefined objects from a list.
Example: RemoveUndefined[Sequence[ (-1) i, i, -3, -1, 0.5]] removes
the second and fourth element of the sequence which have a non-integer exponent
and therefore, are undefined.

Reverse

Reverse [List]: Reverses the order of a list.

Sequence

Sequence [Expression, Variable i, Number a, Number b]: Yields a list of
objects created using the given expression and the index i that ranges from number
a to number b.

Example: . = Sequence[ (2, 1), i, 1, 5] creates a list of points whose y-
coordinates range from 1to 5: L ={(2, 1), (2, 2), (2, 3), (2, 4), (2, 5)}.

Sequence [Expression, Variable i, Number a, Number b, Increment]: Yields
a list of objects created using the given expression and the index i that ranges from
number a to number b with given increment.

Example: I. = Sequence[ (2, i), i, 1, 3, 0.5] creates a list of points whose
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y-coordinates range from 1 to 3 with an increment of 0.5:
L={(2,1), (2, 1.5),(2 2), (2 2.5), (2, 3)}.

Note: Since the parameters a and b are dynamic you could use slider variables as well.

Sort

Sort [List]: Sorts a list of numbers, text objects, or points.
Note: Lists of points are sorted by x-coordinates.
Examples:
e Sort[{3, 2, 1}] givesyouthelist{1, 2, 3}.
e Sort[{"pears", "apples", "figs"}] givesyou the list elementsin
alphabetical order.
e Sort[{(3, 2), (2, 5), (4, 1)}]givesyou{(2,5),(3 2) (4 1)}

Sum

Sum[List]: Calculates the sum of all list elements.
Note: This command works for numbers, points, vectors, text, and functions.
Examples:
e sSum[{1, 2, 3}] givesyouanumbera=6.
e sSum[{x"2, x~3}] givesyouf(x)=x"+x.
e Sum[Sequence[i,i,1,100]] givesyouanumber a=5050.
e Sum[{ (1, 2), (2, 3)}] givesyoua pointA=(3,5).
e sSum[{ (1, 2), 3}] givesyou pointB=(4,2).
e sSum[{"a","b","c"}] gives you the text "abc".
Sum[List, Number n of Elements]: Calculates the sum of the first n list elements.
Note: This command works for numbers, points, vectors, text, and functions.
Example: Sum[{1, 2, 3, 4, 5, 6}, 4] givesyouthe number a=10.

Take

Take[List, Start Position m, End Position n]:Returns a list containing the
elements from positions m to n of the initial list.

Union

Union[List 1, List 21]:Joins the two lists and removes elements that appear multiple
times.

3.3.18. Geometric Transformation Commands

Dilate

UK English: Enlarge

Dilate[Point A, Number, Point S]: Dilates point A from point S using the given
factor.
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Dilate[Line, Number, Point S]: Dilates the line from point S using the given factor.

Dilate[Conic, Number, Point S]: Dilates the conic section from point S using the
given factor.

Dilate[Polygon, Number, Point S]: Dilates the polygon from point S using the given
factor.
Note: New vertices and segments are created too.

Dilate[Image, Number, Point S]: Dilates the image from point S using the given
factor.

Note: Also see tool = Dilate Object from Point

Reflect

Reflect[Point A, Point B]:Reflects point A about point B.
Reflect[Line, Point]: Reflects the line about the given point.
Reflect[Conic, Point]: Reflects the conic section about the given point.
Reflect[Polygon, Point]: Reflects the polygon about the given point.

Note: New vertices and segments are created as well.
Reflect[Image, Point]: Reflects the image about the given point.
Reflect[Point, Line]: Reflectsthe point about the given line.
Reflect[Line g, Line h]: Reflects line g about line h.
Reflect[Conic, Line]: Reflects the conic section about the line.
Reflect[Polygon, Line]:Reflects the polygon about the line.

Note: New vertices and segments are created as well.
Reflect[Image, Line]: Reflectsthe image about the line.
Reflect[Point, Circle]: Inverts the pointin the circle.

Note: Also see tools Reflect Object about Point; o~ Reflect Object about Line;
L Reflect Point about Circle

Rotate

Rotate[Point, Angle]: Rotates the point by the angle around the axis origin.

Rotate[Vector, Angle]: Rotates the vector by the angle around the starting point of
the vector.

Rotate[Line, Angle]: Rotates the line by the angle around the axis origin.

Rotate[Conic, Angle]: Rotates the conic section by the angle around the axis origin.

Rotate[Polygon, Angle]:Rotates the polygon by the angle around the axis origin.
Note: New vertices and segments are created as well.

Rotate[Image, Angle]:Rotates the image by the angle around the axis origin.

Rotate[Point A, Angle, Point B]: Rotates point A by the angle around point B.

Rotate[Line, Angle, Point]:Rotates the line by the angle around the point.

Rotate[Vector, Angle, Point]: Rotates the vector by the angle around the point.

Rotate[Conic, Angle, Point]:Rotates the conic section by the angle around the
point.

Rotate[Polygon, Angle, Point]: Rotates the polygon by the angle around point B.
Note: New vertices and segments are created as well.

Rotate[Image, Angle, Point]:Rotatesthe image by the angle around the point.

[
[
[
[
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Note: Also see tool -+ Rotate Object around Point by Angle

Translate

Translate[Point, Vector ]:Translates the point by the vector.
Translate[Line, Vector]:Translates the line by the vector.
Translate[Conic, Vector]: Translates the conic by the vector.
Translate [Function, Vector]: Translates the function by the vector.
Translate[Polygon, Vector]: Translates the polygon by the vector.
Note: New vertices and segments are created as well.
Translate[Image, Vector]: Translates the image by the vector.
Translate[Vector, Point]: Translates the vector vto point.

Note: Also see tool *~ Translate Object by Vector

3.3.19. Statistics Commands

BarChart

BarChart[Start Value, End Value, List of Heights]: Creates a bar chart over
the given interval where the number of bars is determined by the length of the list
whose elements are the heights of the bars.

Example: BarChart[10, 20, {1,2,3,4,5} ] givesyou a bar chart with five

bars of specified height in the interval [10, 20].
BarChart[Start Value a, End Value b, Expression, Variable k, From

Number c, To Number d]:Creates a bar chart over the given interval [ag, b], that
calculates the bars’ heights using the expression whose variable k runs from number
c to numberd.

Example: If p=0.1, g =0.9, and n = 10 are numbers, then
BarChart[ -0.5, n + 0.5,

BinomialCoefficient[n,k]*p~"k*g” (n-k), k, 0, n ] givesyou a bar chart
in the interval [-0.5, n+0.5]. The heights of the bars depend on the probabilities

calculated using the given expression.
BarChart[Start Value a, End Value b, Expression, Variable k, From

Number c, To Number d, Step Width s]:Creates a bar chart over the given
interval [a, b], that calculates the bars’ heights using the expression whose variable k
runs from number ¢ to number d using step width s.
BarChart [List of Raw Data, Width of Bars]: Creates a bar chart using the given
raw data whose bars have the given width.
Example: BarChart[ {1,1,1,2,2,2,2,2,3,3,3,5,5,5,5}, 1]
BarChart[List of Data, List of Frequencies]:Creates a bar chart using the list
of data with corresponding frequencies.
Note: The List of data must be a list where the numbers go up by a constant amount.
Examples:
e BarChart[{10,11,12,13,14}, {5,8,12,0,1}]
e BarChart[{5, 6, 7, 8, 9}, {1, 0, 12, 43, 3}]
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e BarChart[{0.3, 0.4, 0.5, 0.6}, {12, 33, 13, 4}]
BarChart[List of Data , List of Frequencies, Width of Bars w]: Creates
a bar chart using the list of data and corresponding frequencies whose bars are of
width w.
Note: The List of data must be a list where the numbers go up by a constant amount
Examples:
e BarChart[{10,11,12,13,14}, {5,8,12,0,1}, 0.5] leaves gaps
between bars.
e BarChart([{10,11,12,13,14}, {5,8,12,0,1}, 0] produces a line
graph.

BoxPlot

BoxPlot [yOffset, yScale, List of Raw Data]: Creates a box plot using the given
raw data and whose vertical position in the coordinate system is controlled by
variable yOffset and whose height is influenced by factor yScale.

Example: BoxPlot [0, 1, {2,2,3,4,5,5,6,7,7,8,8,8,9}]

BoxPlot [yOffset, yScale, Start Value a, Ql, Median, Q3, End Value

b]: Creates a box plot for the given statistical data in interval [a, b].

CorrelationCoefficient

CorrelationCoefficient[List of x-Coordinates, List of y-
Coordinates]: Calculates the product moment correlation coefficient using the
given x- and y-coordinates.

CorrelationCoefficient[List of Points]: Calculates the product moment
correlation coefficient using the coordinates of the given points.

Covariance

Covariance[List 1 of Numbers, List 2 of Numbers]: Calculates the covariance
using the elements of both lists.

Covariance[List of Points]: Calculates the covariance using the x- and y-coordinates
of the points.

FitLine

FitLine[List of Points]: Calculates the y on x regression line of the points.
FitLineX[List of Points]: Calculates the x on y regression line of the points.

Note: Also see tool :* Best Fit Line

Other Fit Commands

FitExp[List of Points]: Calculates the exponential regression curve.

FitLog[List of Points]: Calculates the logarithmic regression curve.

FitLogistic[List of Points]: Calculates the regression curve in the form
a/(1+b x*(-kx)).
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Note: The first and last data point should be fairly close to the curve. The list should
have at least 3 points, preferably more.
FitPoly[List of Points, Degree n of Polynomial]: Calculates the regression
polynomial of degree n.
FitPow[List of Points]: Calculates the regression curve in the form a X
Note: All points used need to be in the first quadrant of the coordinate system.
FitSin[List of Points]: Calculates the regression curve in the form
a+bsin(cx +d).
Note: The list should have at least 4 points, preferably more. The list should cover at
least two extremal points. The first two local extremal points should not be too
different from the absolute extremal points of the curve.

Histogram

Histogram[List of Class Boundaries, List of Heights]: Creates a histogram
with bars of the given heights. The class boundaries determine the width and
position of each bar of the histogram.

Example: Histogram[{O, 1, 2, 3, 4, 5}, {2, 6, 8, 3, 1}] createsa
histogram with 5 bars of the given heights. The first bar is positioned at the interval
[0, 1], the second bar is positioned at the interval

[1, 2], and so on.

Histogram[List of Class Boundaries, List of Raw Data]: Createsa
histogram using the raw data. The class boundaries determine the width and
position of each bar of the histogram and are used to determine how many data
elements lie in each class.

Example: Histogram[{1, 2, 3, 4},{1.0, 1.1, 1.1, 1.2, 1.7, 2.2,
2.5, 4.0}] creates a histogram with 3 bars, with the heights 5 (first bar), 2
(second bar), and 1 (third bar).

InverseNormal

InverseNormal [Mean u, Standard Deviation o, Probability P]: Calculates
the function ®”(P) * o + u where @ ™ is the inverse of the probability density
function @ for N(0,1).

Note: Returns the x-coordinate with the given probability to the left under the
normal distribution curve.

Mean commands

Mean[List of Numbers]: Calculates the mean of the list elements.

MeanX[List of Points]: Calculates the mean of the x-coordinates of the points in the
list.

MeanY [List of Points]: Calculates the mean of the y-coordinates of the points in the
list.

Median

Median[List of Numbers]: Determines the median of the list elements.
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Mode

Mode [List of Numbers]: Determines the mode(s) of the list elements.

Examples:
e Mode[{1,2,3,4}] returnsanempty list {}.
e Mode[{1l,1,1,2,3,4}] returnsthe list {1}.
e Mode[{1,1,2,2,3,3,4}] returnsthe list {1, 2, 3}.

Normal

Normal [Mean u, Standard Deviation o, Variable Value x]: Calculates the
function @((x — u) / a) where @ is the probability density function for N(0,1) .
Note: Returns the probability for a given x-coordinate value (or area under the
normal distribution curve to the left of the given x-coordinate).

Quartile commands

Ql[List of Numbers]: Determines the lower quartile of the list elements.
03[List of Numbers]: Determines the upper quartile of the list elements.

SD

SD[List of Numbers]: Calculates the standard deviation of the numbers in the list.

Sigma commands

SigmaXX[List of Numbers]: Calculates the sum of squares of the given numbers.
Example: In order to work out the variance of a list you may use

SigmaXX[list]/Length[list] - Mean[list]"2.
SigmaXX[List of Points]: Calculates the sum of squares of the x-coordinates of the
given points.

SigmaXY[List of x-Coordinates, List of y-Coordinates]: Calculates the sum
of the products of the x- and y-coordinates.

SigmaXY[List of Points]: Calculates the sum of the products of the x- and y-
coordinates.
Example: You can work out the covariance of a list of points using

SigmaXY[list]/Length[list] - MeanX[list] * MeanY[list].
SigmaYY[List of Points]: Calculates the sum of squares of y-coordinates of the given
points.

Commands for statistic quantities

Sxx[List of Numbers]: Calculates the statistic 5(x?) - 5(x) * 5(x)/n.

Sxx[List of Points]: Calculates the statistic 5(x°) - £(x) * 2(x)/n using the x-coordinates
of the given points.

Sxy[List of Numbers, List of Numbers]: Calculates the statistic
S(xy) - 2(x) * 2(y)/n.

Sxy[List of Points]: Calculates the statistic 3(xy) - 2(x) * 2(y)/n.
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Syy[List of Points]: Calculates the statistic S(y’) - 5(y) * (y)/n using the y-coordinates
of the given points.

Note: These quantities are simply unnormalized forms of the variances and covariance of X
and Y given by Sxx = N var(X), Syy = N var(Y), and Sxy = N cov(X, Y).

Example: You can work out the correlation coefficient for a list of points using

Sxy[list] / sqgrt(Sxx[list] Syyl[list]).

Variance

Variance[List of Numbers]: Calculates the variance of list elements.

3.3.20. Spreadsheet Commands

CellRange

CellRange[Start Cell, End Cell]:Creates a list containing the cell values in this cell
range.
Example: Enter the following values into the corresponding spreadsheet cells:
Al = 1,A2 = 4,A3 = 9.Thecommand CellRange[Al, A3] then gives you the
list {1, 4, 9}.

Column

Column[Spreadsheet Cell]: Returns the column of the cell as a number (starting at 1).
Example: Column [B3] gives you number a = 2 since column B is the second column
of the spreadsheet.

ColumnName

ColumnName [Spreadsheet Cell]: Returnsthe column name of the cell as a text.
Example: ColumnName [A1] gives you a text “A” in the Graphics View.

Row

Row [Spreadsheet Cell]: Returnsthe row number of a spreadsheet cell (starting at 1).
Example: Row [B3] gives you number a = 3.

3.3.21. Matrix Commands
Determinant

Determinant [Matrix]: Returns the determinant of the matrix.
Example: Determinant [{{1, 2}, {3, 4}}] givesyouthe number a=-2.
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Invert

Invert [Matrix]: Inverts the given matrix.
Example: Invert [{{1, 2}, {3, 4}}] givesyou the inverse matrix
{{-2, 1}, {1.5, -0.5}}.

Transpose

Transpose[Matrix]: Transposes the matrix.
Example: Transpose [{{1, 2}, {3, 4}}] givesyou the matrix {{1, 3}, {2, 4}}.
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4. Menu ltems

4.1. File Menu

L) New Window
Keyboard shortcut: Ctrl-N (Mac OS: Cmd-N)

This menu item opens a new GeoGebra window that uses the default settings of the
GeoGebra user interface.

Note: If you change and save some of these settings, the new GeoGebra window will open
using your customized settings.

New

This menu item opens a new and empty user interface in the same GeoGebra window. You
are asked if you would like to save the existing construction before opening the new user
interface.

Note: The new user interface adopts the settings used for the prior construction. For
example, if the coordinate axes were hidden before selecting the menu item New, the axes
will be hidden in the new user interface as well.

(= Open...
Keyboard shortcut: Ctrl-O (Mac OS: Cmd-O)

This menu item allows you to open a GeoGebra file (file name extension GGB) that is saved
on your computer.

Note: In order to open a GeoGebra file you can also drag it with the mouse to the GeoGebra
window and drop it there.

[¥ save
Keyboard shortcut: Ctr/-S (Mac OS: Cmd-S)

This menu item allows you to save your current construction as a GeoGebra file (file name
extension GGB) on your computer.

Note: If the file was saved before, this menu item overwrites the old file by using the same
file name.
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Save As...

This menu item allows you to save your current construction as a GeoGebra file (file name
extension GGB). You will be asked to enter a new name for your GeoGebra file before it is
saved on your computer.

i Print Preview

Keyboard shortcut: Ctr/-P (Mac OS: Cmd-P)

This menu item opens the Print Preview window for the Graphics View. You may specify
Title, Author, Date and the Scale of your printout (in cm).

Note: Press the Enter-key after you made a change in order to update the preview of your
printout.

Export - & Dynamic Worksheet as Webpage (html)...
Keyboard shortcut: Ctrl-Shift-W (Mac OS: Cmd-Shift-W)

This menu item allows you to export your current construction as a webpage (HTML) in
order to create a so called Dynamic Worksheet.
Please see section Creating Interactive Webpagesfor more information.

Export - (=] Graphics View as Picture (png, eps)...
Keyboard shortcut: Ctr/-Shift-P (Mac OS: Cmd-Shift-P)

This menu item allows you to save GeoGebra’s Graphics View as a picture file on your
computer. In the appearing dialog window, you can select the picture file Format, and
change the Scale (in cm) and Resolution (in dpi) of the picture.

When exporting the Graphics View as a picture you can choose out of the following formats:

e PNG - Portable Network Graphics: This is a pixel graphics format. The higher the
resolution (dpi), the better the quality (300dpi will usually suffice). PNG graphics
should not be scaled subsequently to avoid a loss of quality.

PNG graphic files are well suited for the use on web pages (HTML) and in word
processing documents.

Note: Whenever you insert a PNG graphic file into a word processing document
(menu Insert, Image from file) make sure that the size is set to 100 %. Otherwise the
given scale (in cm) would be changed.

e EPS - Encapsulated Postscript: This is a vector graphics format. EPS pictures may be
scaled without loss of quality. EPS graphic files are well suited for the use with vector
graphics programs (e. g., Corel Draw) and professional text processing systems (e. g.,
LaTeX).

The resolution of an EPS graphic is always 72dpi. This value is only used to calculate
the true size of an image in centimeters and has no effect on the image's quality.
Note: The transparency effect with filled polygons or conic sections is not possible
with EPS.
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e PDF - Portable Document Format (see EPS format above)
Note: In SVG and PDF export you have the option to export text as editable text or
shapes. This stores the text either as text (this lets you edit the text in e. g., InkScape)
or as Bézier curves (this guarantees that the text looks the same even if the correct
font is not installed).

e SVG - Scaleable Vector Graphic (see EPS format above)

e EMF - Enhanced Meta Format (see EPS format above)

Export - [/ Graphics View to Clipboard
Keyboard shortcut: Ctrl-Shift-C (Mac OS: Cmd-Shift-C)

This menu item copies the Graphics View to your computer’s clipboard. Afterwards, you can
easily paste this picture into other documents (e. g., word processing document).

Export - Graphics View as PSTricks...
Keyboard shortcut: Ctrl-Shift-T (Mac OS: Cmd-Shift-T)

This menu item allows you to save the Graphics View as a PSTricks picture file, which is a
LaTeX picture format.

Export - Graphics View as PGF/TikZ......

This menu item allows you to save the Graphics View as a PGF/TikZ picture file, which is a
LaTeX picture format.

g Close

Keyboard shortcut: Alt-F4 (Mac OS: Cmd-W)

This menu item closes the GeoGebra window. If you didn’t save your construction prior to
selecting Close, you are asked if you would like to do so.

4.2. Edit Menu

Undo
Keyboard shortcut: Ctrl-Z (Mac OS: Cmd-Z)

This menu item allows you to undo your activities step by step.
Note: You can also use the “~i Undo button to the right of the Toolbar.

# Redo
Keyboard shortcut: Ctrl-Y (Mac OS: Cmd-Shift-Z)
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This menu item allows you to redo your activities step by step.
Note: You can also use the @ Redo button to the right of the Toolbar.

'/ Delete

Keyboard shortcut: Delete key

This menu items allows you to delete selected objects and their dependent objects.
Note: You need to select the objects you want to delete first (e. g., use a selection
rectangle).

Select All
Keyboard shortcut: Ctrl-A (Mac OS: Cmd-A)

This menu item allows you to select all objects used in your construction.

Select Current Layer

Keyboard shortcut: Ctrl-L (Mac OS: Cmd-L)

This menu item allows you to select all objects that are on the same layer as a selected
object.

Note: You need to select one object that lies on the desired layer prior to using this menu
item.

Select Descendants

Keyboard shortcut: Ctrl-Shift-Q (Mac OS: Cmd-Shift-Q)

This menu item allows you to select all objects that depend on the selected object.
Note: You need to select the parent object prior to using this menu item.

Select Ancestors

Keyboard shortcut: Ctrl-Q

This menu item allows you to select all objects that are ancestors of the selected object,
meaning all objects the selected one depends on.
Note: You need to select the dependent object prior to using this menu item.

- Graphics View to Clipboard
Keyboard shortcut: Ctrl-Shift-C (Mac OS: Cmd-Shift-C)

This menu item copies the Graphics View to your computer’s clipboard. Afterwards, you can
easily paste this picture into other documents (e. g., word processing document).
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& Properties...
Keyboard shortcut: Ctrl-E (Mac OS: Cmd-E)

This menu item opens the Properties Dialog which allows you to modify the properties of all
objects used in the GeoGebra file.

4.3. View Menu

1— Axes

This menu item allows you to show or hide the coordinate axes in the Graphics View.
Note: You can use the Properties Dialog for Graphics View in order to customize the
coordinate axes.

£ Grid

This menu item allows you to show or hide the coordinate grid in the Graphics View.
Note: You can use the Properties Dialog for Graphics View in order to customize the
coordinate grid.

Algebra View
Keyboard shortcut: Ctrl-Shift-A (Mac OS: Cmd-Shift-A)

This menu item allows you to show or hide the Algebra View.

Spreadsheet View
Keyboard shortcut: Ctrl-Shift-S (Mac OS: Cmd-Shift-S)

This menu item allows you to show or hide the Spreadsheet View.

Auxiliary Objects

This menu item allows you to show or hide auxiliary objects in the Algebra View.

Horizontal Splitting

This menu item allows you to split the GeoGebra window either vertically or horizontally
into the different views.

Input Bar

This menu item allows you to show or hide the Input Bar at the bottom of the GeoGebra
window.
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Command List

This menu item allows you to show or hide the list of commands next to the Input Bar at the
bottom of the GeoGebra window.

£ Construction Protocol...

This menu item allows you to open the Construction Protocol in a new window.

Navigation Bar for Construction Steps

This menu item allows you to show or hide the Navigation Bar at the bottom of the Graphics
View.

{3 Refresh Views
Keyboard shortcut: Ctrl-F (Mac OS: Cmd-F)

This menu item allows you to repaint all views on screen.
Note: You can use this menu item to delete any traces of points or lines in the Graphics
View.

Recompute All Objects
Keyboard shortcut: F9

This menu item recomputes all objects used in your GeoGebra file.
Note: You can use this menu item to create new random numbers if you used any in your
GeoGebra file.

4.4. Options Menu

Global options may be changed in the menu Options.
Note: To change object settings, please use the Context Menu and Properties Dialog.

< Point Capturing

This menu item determines if the point capturing is On or Off or if points are captured by
the grid (item On (Grid)).

Note: Option Automatic turns the point capturing On when the grid or the coordinate
system are shown and turns it Off if they are hidden.

<. Angle Unit

This menu item determines whether angles are displayed in Degree (°) or Radians (rad).
Note: Input is always possible in both ways (degree and radian).
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Rounding

This menu item allows you to set the number of decimal places or significant figures
displayed on screen.

Continuity

GeoGebra allows you to turn the continuity heuristic On or Off in the Options menu. The
software uses a near-to-heuristic to keep moving intersection points (e. g., line-conic, conic-
conic) close to their old positions and avoid jumping intersection points.

Note: By default this heuristic is turned off. For user defined tools continuity is always
turned off as well.

" Point Style

This menu item determines whether by default points are displayed as ® dots, o circles, or x
crosses.

|7 Checkbox Size

This menu item allows you to set the size of checkboxes to Regular or Large.

Note: If you are using GeoGebra as a presentation tool or are working with an interactive
whiteboard, setting the checkbox size to Large might make it easier for you to use
checkboxes.

b Right Angle Style

Determines whether right angles are displayed as a rectangle 0O, a dot e, or like all other
angles (Off).

Coordinates

This menu item determines whether coordinates of points are displayed as A = (x, y) or
Alx [y).

A% Labeling

You can specify whether the label of a newly created object should be shown or not. You
can choose between the settings All New Objects, No New Objects, New Points Only, and
Automatic.

Note: The setting Automatic shows the labels of newly created objects if the Algebra View is
shown.

Al Font Size

This menu item determines the font size for labels and text in points (pt).
Note: If you are using GeoGebra as a presentation tool, increasing the font size makes it
easier for your audience to read text, labels, and algebraic input you are using.
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@ Language

GeoGebra is multilingual and allows you to change the current language setting. This affects
all input including command names and all output.

Note: No matter which language was selected, the globe icon @ will lead you back to the
language menu. All language names are always displayed in English.

@& Drawing Pad

This menu item opens a dialog where properties of the Drawing Pad (e. g. coordinate grid
and axes, background color) can be set.

Note: You can also open this dialog window by right clicking (Mac OS: Ctrl-click) on the
drawing pad.

[ save Settings

GeoGebra remembers your favorite settings (e. g., settings in the Options menu, current
Toolbar and Graphics View settings) if you select Save settings in the Options menu.

Restore Default Settings

You can restore the default settings of GeoGebra using this menu item.

4.5. Tools Menu

3% Create New Tool...

Based on an existing construction you can create your own tools in GeoGebra. After
preparing the construction of your tool, choose Create new tool in the Tools menu. In the
appearing dialog you can specify the output and input objects of your tool and choose
names for the Toolbar icon and corresponding command.

Note: Your tool can be used both with the mouse and as a command in the Input Bar. All
tools are automatically saved in your GGB construction file.

@& Manage Tools...

Using the Manage tools dialog you can delete a tool or modify its name and icon. You can
also save selected tools to a GeoGebra Tools File (GGT). This file can be used later on (File
menu, Open) to load the tools into another construction.

Note: Opening a GGT file doesn’t change your current construction, but opening a GGB file
does.

Customize Toolbar...

You can customize the tools in GeoGebra’s Toolbar by selecting Customize Toolbar in the
menu Tools. This is especially useful for Dynamic Worksheets where you want to restrict the
available tools in the Toolbar.
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Note: The current Toolbar setting is saved with your construction in a GGB file.

4.6. Window Menu

L) New Window
Keyboard shortcut: Ctrl-N (Mac OS: Cmd-N)

This menu item opens a new GeoGebra window that uses the default settings of the
GeoGebra interface.

Note: If you change and save some of these settings the new GeoGebra window will open
using your customized settings.

List of Open GeoGebra Windows

If you have more than one GeoGebra window open, this menu item allows you to switch
between these different windows.

Note: This might be helpful when you are using GeoGebra as a presentation tool and want
to have several GeoGebra files open at the same time as well as to toggle between them.

4.7. Help Menu

(7] Help

This menu item gives you access to the HTML-version of the GeoGebra Help document.
Depending on how you installed GeoGebra on your computer you may need Internet access
for this feature:

e If you downloaded and installed GeoGebra using the installer file from the webpage,
you don’t need Internet access in order to use the help feature. The HTML-version of
the GeoGebra Help document is locally saved on your computer when you install
GeoGebra.

e If you used GeoGebraWebstart to install GeoGebra on your computer, you need to
have Internet access in order to use this help feature. If you don’t have Internet
access, you will get an error message.

Note: The HTML-version of this GeoGebra Help document is available online at
http://www.geogebra.org/help.

| ) www.geogebra.org

If you have Internet access, this menu item opens the GeoGebra webpage in your default
web browser (http://www.geogebra.org).
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a3 GeoGebra Forum

If you have Internet access, this menu item opens the GeoGebra online User Forum in your
default web browser (http://www.geogebra.org/forum).

Note: You can post and answer GeoGebra-related questions and problems in the GeoGebra
User Forum.

© GeoGebraWiki

If you have Internet access, this menu item opens the GeoGebraWiki webpage in your
default web browser (http://www.geogebra.org/wiki).

Note: The GeoGebra Wiki is a pool of free instructional materials created with GeoGebra by
users from all around the world.

i About / License

This menu item opens a dialog window that gives you information about the license of
GeoGebra and gives credit to people who support the GeoGebra project by contributing in
many different ways (e. g., programming, translations).
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5. Special GeoGebra Features

5.1. Animation

5.1.1. Automatic Animation

GeoGebra allows you to animate one or several free numbers and/or angles at the same
time if they are shown as sliders in the Graphics View.

If you want to animate a free number or angle in GeoGebra, you need to right click (Mac OS:
Ctrl-click) on the number or angle and select Animation On from the appearing Context
Menu. In order to stop the animation, you need to un-check Animation On in the same
Context Menu.

Note: After animating a free number or a free angle, an animation button appears in the
lower left corner of the Graphics View. It allows you to either [l pause or [ continue an
animation.

In the Properties Dialog on tab Slider you can change the behavior of the animation:
On the one hand, you may control the Speed of the animation.
Note: A speed of 1 means that the animation takes about 10 seconds to run once through
the interval of the slider.
On the other hand, you may change how the animation cycle is repeated:
e <=> Oscillating:
The animation cycle alternates between Decreasing and Increasing.
e =>/ncreasing:
The slider value is always increasing. After reaching the maximum value of the slider,
it jumps back to the minimum value and continues the animation.
e <= Decreasing:
The slider value is always decreasing. After reaching the minimum value of the slider,
it jumps back to the maximum value and continues the animation.

Note: While an automatic animation is activated, GeoGebra remains fully functional. This
allows you to make changes to your construction while the animation is playing.

5.1.2. Manual Animation
To manually change a number or angle continuously, select the & Move tool. Then, click on

a free number or angle and press either the + or — key or the arrow keys on you keyboard.
Keeping one of these keys pressed allows you to produce manual animations.
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Example: If a point’s coordinates depend on a number k like in P = (2 k, k), the point will
move along a straight line when k is changed continuously.

Note: You can adjust the increment of the slider on tab Slider of the Properties Dialog of this
object.

Keyboard Shortcuts:
e Shift + arrow key gives you a step width of 0.1 units
e Ctrl + arrow key gives you a step width of 10 units
e Alt+ arrow key gives you a step width of 100 units

Note: A point on a line can also be moved along its line using the + or — key.

5.2. Conditional Visibility

Apart from just showing or hiding certain objects you can also have their visibility status
depend on a certain condition. For example, you would like an object to appear on screen if
you check a checkbox positioned in the Graphics View or if a slider is changed to a certain
value.

Conditionally Show or Hide Existing Objects

You can use the tool ®5 Checkbox to Show / Hide Objects in order to create a checkbox that
controls the visibility of one or more existing objects on screen. Alternatively, you could also
create a Boolean variable (e. g.,,b = true) using the Input Bar and make it visible as a
checkbox in the Graphics View by changing its visibility status (e. g., use tool "= Show / Hide
Object or use the Context Menu). In order to use this Boolean variable as a condition for the
visibility of certain objects, you need to follow the steps described below.

Changing the Visibility of Newly Created Objects

In the Properties Dialog, you can enter a condition for the visibility of an object on tab
Advanced.

Note: You can select the logic operators (e. g., #, 2, A, II) from the drop down menu in order
to create your conditional statements.

Examples:

e |If ais aslider, then the conditional statement a < 2 means that the corresponding
object is only shown in the Graphics View if the slider’s value is less than 2.

e |If bisaBoolean variable, you can use b as a conditional statement. The
corresponding object is shown whenever the value of b is true and is hidden when
the value of b is false.

e If gand h are two lines and you would like a text to be shown whenever these lines
are parallel, then you could use g || h as a conditional statement for the text.
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5.3. User Defined Tools

GeoGebra allows you to create your own construction tools based on an existing
construction. Once created, your custom tool can be used both with the mouse and as a
command in the Input Bar. All tools are automatically saved in your GeoGebra file.

Creating a User Defined Tool

First, create the construction your tool should be able to create later on. In the Tools menu,
click on & Create New Tool in order to open the corresponding dialog box. Now you need to
fill in the three tabs Output Objects, Input Objects, and Name and Icon in order to create
your custom tool.

Example:
Create a Square-tool that creates a square whenever you click on two existing points or on

two empty spots in the Graphics View.

e Construct a square starting with two points A and B. Construct the other vertices and
connect them with the tool +* Polygon to get the square poly1.

e Select 3% Create New Tool in the Tools menu.

o Specify the Output Objects: Click on the square or select it from the drop down
menu. Also, specify the edges of the square as Output Objects.

e Specify the Input Objects: GeoGebra automatically specifies the Input Objects for you
(here: points A and B). You can also modify the selection of input objects using the
drop down menu or by clicking on them in your construction.

e Specify the Tool Name and Command Name for your new tool.

Note: The Tool Name will appear in GeoGebra’s Toolbar, while the Command Name
can be used in GeoGebra’s Input Bar.

e You may also enter text to be shown in the Toolbar Help.

e You can also choose an image from you computer for the Toolbar icon. GeoGebra
resizes your image automatically to fit on a Toolbar button.

Saving a User Defined Tool

You can save your custom tools so you can reuse them in other GeoGebra constructions. In
the Tools menu, select @& Manage Tools. Then, select the custom tool you want to save
from the appearing list. Click on button Save As... in order to save your custom tool on your
computer.

Note: User defined tools are saved as files with the file name extension GGT so you can
distinguish custom tool files from usual GeoGebra files (GGB).

Accessing a User Defined Tool

If you open a new GeoGebra interface using item New from the File menu, after you created
a custom tool, it will still be part of the GeoGebra Toolbar. However, if you open a new
GeoGebra window (item L) New Window from the File menu), or open GeoGebra on
another day, your custom tools won’t be part of the Toolbar any more.
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There are different ways of making sure that your user defined tools are displayed in the
Toolbar of a new GeoGebra window:

e After creating a new user defined tool you can save your settings using item @ save
Settings from the Options menu. From now on, your customized tool will be part of
the GeoGebra Toolbar.

Note: You can remove the custom tool from the Toolbar after opening item
Customize Toolbar... from the Tools menu. Then, select your custom tool from the
list of tools on the left hand side of the appearing dialog window and click button
Remove >. Don’t forget to save your settings after removing the custom tool.

e After saving your custom tool on your computer (as a GGT file), you can import it
into a new GeoGebra window at any time. Just select item = Open from the File
menu and open the file of your custom tool.

Note: Opening a GeoGebra tool file (GGT) in GeoGebra doesn’t affect your current
construction. It only makes this tool part of the current GeoGebra Toolbar.

5.4. Dynamic Colors

In GeoGebra, you can change the color of objects using tab Color of the Properties Dialog.
However, you can also have the color of an object change dynamically: Open the Properties
Dialog for a certain object whose color you would like to change and click on tab Advanced.
There you will find a section called Dynamic Colors with text boxes for the color components
Red, Green, and Blue.

Note: In each of these text boxes, you can enter a function with range [0, 1].

Example:

e Create three sliders a, b, and ¢ with an interval from 0 to 1.

e Create a polygon whose color should be influenced by the slider values.

e Open the Properties Dialog for the polygon polyl and enter the names of the three
sliders into the text boxes for the color components.

e Close the Properties Dialog and change the values of the sliders in order to find out
how each color component influences the resulting color of the polygon.
Note: You could also animate the sliders with different speeds in order to see the
color of the polygon change automatically.

5.5. JavaScript Interface

Note: GeoGebra’s JavaScript interface is interesting for users who have some experience in
HTML editing.

In order to enhance your Dynamic Worksheets and increase their interactivity, GeoGebra
applets provide a JavaScript interface. For example, you could create a button to randomly
generate new configurations of a dynamic construction.
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Please, see the document GeoGebra Applets and JavaScript (http://www.geogebra.org in

Help) for examples and information about using JavaScript with GeoGebra applets.

5.6. Keyboard Shortcuts
Ctrl-Shift
Key [plain] Cerl (Mac OS: Alt
(Mac 0S: Cmd) Cmd-Shift) (Mac OS: Ctrl)
A Select All Show/hlde alpha a
Algebra View
beta
Copy Export
C (Spreadsheet Graphics View
View) to Clipboard
D delta &
E Properties Dialog Euler e
F Refresh views phi ¢
G gammay
H
I
J
K
L Select current lambda A
layer
M mu p
N New window
0] Open degree symbol °
Export
Graphics
P Print preview | View as pi
Picture
(png, eps)...
Select Select
Q descendants ancestors
R
Show / hide
S Save Spreadsheet sigma o
View
Export as
T PS'FI)'ricks theta ©
U
Paste
\Y (Spreadsheet
View)
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Ctrl-Shift

. Ctrl Alt
Key [plain] (Mac 0S: Cmd) z:“rnn?:lcscimslft) (Mac OS: Ctrl)
Export
Dynamic
w (CI\I/T:Ce 05 only) Worksheet | omega w
as Webpage
(html)
X
Y Redo
z Undo
0 Exponent0
1 Exponent1
2 Exponent2
3 Exponent3
4 Exponent4
5 Exponent5
6 Exponent6
7 Exponent7
8 Exponent8
9 Exponent9
Decrease selected .
- Zoom Out minus-or-plus
number / angle
Increase selected .
+ Zoom In plus-or-minus +
number / angle
Increase selected
= Zoom In not-equal-to #
number / angle
< less-than-or-equal-to <
, (comma) less-than-or-equal-to <
S greater-than-or-equal-
to 2
_ (period) greater-than-or-equal-
to2
*
F1 Help
Start editing
F2 selected object
(Algebra View)
Insert definition of
F3 selected object
(Input Bar)
Insert value of
F4 selected object

(Input Bar)
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Ctrl-Shift

. Ctrl Alt
Key [plain] (Mac 0S: Cmd) sx:;\slft) (Mac OS: Ctrl)
Insert name of
F5 selected object
(Input Bar)
Update random
F9
numbers
Toggle focus
Enter between Graphics
view and Input Bar
Left-click
Click:
Open Context Menu
(on object)
Right-click (F;Z(z;perzi.esvl?ialog
(Mac Os: :p I':S 'ewd
Ctrl-click) in (on background)
gfeczzhas Click and drag:
Fast Drag Mode
(on object)
Zoom rectangle
(on background)
Scroll Wheel | Zoom in / out Zoom in / out Accelerated Zoom in /
(Applet) Zoom out
Delete DeIete‘: current
selection
Delete current
Backspace .
selection
Increase selected
number / angle
Move selected
point up 10 x0.|1t§r>|§ed
multiplier -
Up arrow T Go to prior entries :jlif;;lier (press Shift x100 speed multiplier
in Input Bar only)
history
Goupin

Construction Protocol
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Ctrl-Shift

Ctrl Alt
Key [plain] . (Mac 0S: .
(Mac 0S: Cmd) Cmd-shift) (Mac OS: Ctrl)
Increase selected
number/angle
%10 x0.1 speed
Right arrow Move selected multiplier .
i . speed . x100 speed multiplier
-> point to the right - (press Shift
multiplier
only)
Goupin
Construction Protocol
Decrease selected
number/angle
Move selected x10 )r(r?dlltis pl?eerd
Left arrow ¢ gve selecte speed P . x100 speed multiplier
point to the left . (press Shift
multiplier
only)
Go down in
Construction Protocol
Decrease selected
number/angle
Move selected
point down 10 x0.1 speed
D Itipli
own arrow speed muttip 'ef x100 speed multiplier
N% Go to newer entry . (press Shift
. multiplier
in Input Bar only)
history
Go downin

Construction Protocol

Home/PgUp

Go to first item in
Construction Protocol

End/PgDn

Go to last item in
Construction Protocol

Additional keyboard commands:

o Alt-Shift (Mac OS: Ctrl-Shift): Upper-case Greek letters

e Spreadsheet View: Ctrl-Alt-C copies values (not the formulae)

Note: The degree symbol ° (Alt-O, Mac OS: Ctrl-0) and the symbol 7t for pi (A/t-P, Mac OS:
Ctrl-P) can also be used in the slider dialog window for interval (min, max) and the

increment.
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5.7. Labels and Captions

Show and Hide Labels

You can show or hide the labels of objects in the Graphics View in different ways:
e Select the tool #* Show / Hide Label and click on the object whose label you would
like to show or hide.
e Open the Context Menu for the desired object and select #* Show Label.
e Open the Properties Dialog for the desired object and check or un-check the
checkbox Show Label on tab Basic.

Name and Value

In GeoGebra, every object has a unique name that can be used to label the object in the
Graphics View. In addition, an object can also be labeled using its value or its name and
value. You can change this label setting in the Properties Dialog on tab Basic by selecting the
corresponding option Name, Value, or Name & Value from the drop down menu next to the
checkbox Show Label.

Note: The value of a point is his coordinates, while the value of a function is its equation.

Caption

However, sometimes you might want to give several objects the same label, for example, to
label the four edges of a square a. In this case, GeoGebra offers captions for all objects in
addition to the three labeling options mentioned above. You can set the caption of an object
on tab Basic of the Properties Dialog by entering the desired caption into the text field called
Caption. Afterwards, you can select the labeling option Caption from the drop down menu
next to the checkbox Show Label.

5.8. Layers

Note: In GeoGebra, layers are used to determine which object to select or drag when the
user clicks on multiple objects at the same time.

By default, all objects are drawn on layer 0, which is basically the background layer of the
Graphics View. A total of 10 layers are available (humbers 0 to 9) and higher numbered
layers are drawn on top of lower numbered layers.

Using the Advanced tab of the Properties Dialog, you can change the layer for a certain
object (layers from 0 to 9 available). Once you change the layer number for at least one
object to be different from layer O (e. g., to layer 3), all new objects will be drawn on the
layer with the highest number that is used for any object.

Note: After selecting any object, you can select all objects in the same layer by selecting

item Select Current Layer (keyboard shortcut: Ctrl-L) from the Edit menu. This menu item is
only available if all selected objects lie on the same layer.
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Further use of layers:
e For SVG export objects are grouped by layer.
e Layers can be controlled using the JavaScript Interface for GeoGebra applets.

5.9. Redefine

Redefining objects is a very versatile tool to change a construction. Please note that this may
also change the order of the construction steps in the Construction Protocol.

In GeoGebra, an object may be redefined in different ways:
e Select the * Move tool and double click on any object in the Algebra View.

o For free objects an editing field is opened allowing you to directly change the
algebraic representation of the object. Hit the Enter-key in order to apply
these changes.

o For dependent objects the Redefine dialog is opened allowing you to redefine
the object.

e Select the * Move tool and double click on any object in the Graphics View. This
opens the Redefine dialog and allows you to redefine the object.

e Change any object by entering its name and the new definition into the /nput Bar.

e Open the Properties Dialog and change the definition of an object on tab Basic.

Note: Fixed objects cannot be redefined. In order to redefine a fixed object, you need to
free it first using tab Basic of the Properties Dialog.

Examples:

e Inorder to place a free point A on an existing line h, you first need to double click on
the point A to open the Redefine dialog window. Then, enter the command
Point [h] in the appearing text field and press the Enter-key. To remove point A
from this line and make it free again, you need to redefine it to some free
coordinates like (1, 2).

e Another example is the conversion of a line h through two points A and B into a
segment. Open the Redefine dialog for line h and enter the command
Segment [A, B] inthe appearing text field.

5.10. Trace and Locus

Objects can leave a trace in the Graphics View when they are moved. Use the Context Menu
to switch this #* Trace On. Then, modify the construction so that the object whose trace you
turned on changes its position and leaves a trace.

Note: You can turn off the trace of an object by un-checking Trace On in the Context Menu.
The menu item & Refresh Views in the View menu clears all traces.
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You can also let GeoGebra automatically create the locus of a point by either using tool
2N Locus with the mouse, or enter the command Locus into the Input field.

Note: The point whose locus you would like to create must depend on another point’s
movement, which is restricted to move along an object (e. g., line, segment, circle).

Example:
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Create a segment a between the points A= (-1, -1)and B=(1, -1).
Place a point C on the segment, so it is restricted to move along segment a.
Create a point P that depends on point C(e.g., P = (x(C), x(C)"2)).
Use either tool or command Locus in order to create the locus of point P in
dependence on point C:

o Tool & Locus: Click first on point P and then on point C.

o Command Locus: Enter Locus [P, C] into the Input Bar and hit the Enter-

key.

Note: The locus created in this example is the graph of a parabola on the interval
[-1, 1].
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TAKE wenteeeeetee e 61
TANGENT...eiiiieiiiiiiie e 50, 54
TaylorPolynomial........ccceeeceeeniieiniieniee e, 53
TOXE ettt 57
TextTOUNICOAE ..ccoueereieiieieeieeeeeeee e 57
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Translate..... ...63
Transpose ..... ...68
TrapeziumSum..... .44
TrapezoidalSum... .44
TurningPoint..... .46

UnicodeToletter.. .57
UnicodeToText..... ...58
UNioN ..ueeeeecciieeeeciieeee ...61
UnitPerpendicularVector........cccoeveeeeieveicniennenne. 48
UNIEVECLON vttt e 48
UpPPerSUM.....ccciviiiiiiiiiiicii e 45
ValANCO ..uuvieeeiiiiiee ettt et e s e e e etbae e s e siaaeee s 67
VECTON ittt s 48
VEITOX teiiiuiiiieeiiiiitee ettt et st e s e e s 47
COMMEANAS c.eeviieeeiiiiee et e e e e erar e e e e 7,39
Accept SUBEESTION.....ccuveiieieiieeeeeece e 40
Angle ComMMANd ....cceevvieeiiee e 45
Arc ComMmMaANGS ...ceeveveeeiiierieeeree e 54
Automatic completion ........cccccveevcieeiciiescie e, 39
Boolean Commands........cceccueeeeeeenieeesieesieeesiee e 40
Change SUBEEeStiON......c.cevvveeiiie e 40
Command list, View Menu ........cccceveeeveveeeeeecrveeeenn, 74
Command syntax, Help.......ccccueeeiieeiieeecieeciie e 7
Conic Section Commands .......ccceeveeeiieeeneeesiieennens 51
Curve CoOmMMaNd .....coovueeeriieenieenieeeniee e esiiee e 53
Function Commands.........coeveeeieeenieennneeniieeeseennane 52
General commands........covevvereereeneeneeneenieeseeenens 40
Geometric Transformation Commands................... 61
Help for commands ........ccoecvevveeveeneeneeneeseesieenneenes 7
Line COMMANAS ....coovuveeriieeiiee e e sree e 49
List COMMANGS ..vvveeiieeciieeciee e stee e e 58
List of commands........cooeuvvevieiiiiienieeeie e, 7
Locus Command ..... ...58
Matrix Commands .. .67
Number Commands............. .41
Parametric Curve Command .53
Point Commands ................. .45
Polygon Command.. ...49
Ray Command......... ...48
Sector Commands... .54
Segment Command ... ...48
Sequence COMMANGS ........ccevereninenenenieieeeeenne 58
Spreadsheet COmMmMaNnds........cccevververeeneeneeneennens 67
Statistics COMMaNds........ccueevcveeririeenieeeieeesiee e 63
Text COMMANAS ..ccevveeriieeriee e e 55
Transformation Commands........cccceeveveviieesiieeennnns 61
Vector COMmMaNds ......ccuveevveeeiieerieeeseeesieeeseeeeeees 47
CoMPASS, OO .eevurieeiiieiiie et 22
ComMPASSES, tOO!.....ecvuiieeiieeciieeciie et 22
Complex number
AdItion ..ceecviieieeeee e 39
DireCt iINPUL...eiieieiiiiee et 38
MUIEIPIICAtION woveeieeciee e 39
OpPerations.......ccevevieiiiniiciicicer 38
SUDBTrACTION c.vveeiiieeeeeeeeee e 39
Conditional funCtions.......cccceeveevieerieiecce e 52
Conditional Visibility......cccovveerieeverieeiercesie e 80
EXiStiNg ODJECES .ovveveerieeieecieeeeeeee e 80
NEW ODJECES ..cvieiieiieieerie ettt 80
Conic section
Conic through Five Points, tool......cccccceevvveeriiveennenn. 22
Conic, COMMANG ......uvveeeieciieee e 51
Dir€Ct iINPUL..eeiieiiiiiieee it 34



NaAME oo 30, 34
Conjugate Diameter, command.........cccceevveeriveeenvennnnen. 49
Construction Protocol........ccccceveeneenennenienieee e 11

Breakpoint........... .12

Change OFdEr ...ccueee it 12

Columns............... 12,13

Export as Webpage .......ccccceecveiiieiienininincenee 12

Export colorful Construction Protocol..............c..... 12

INsert New step ......ccccvvvviiiiiiiiiiiiccec, 12

MOAIfY v 11

Navigate......ccoovviiiiiiiiiiini 11

PrINE e 13

VIeW MENU ..covviiiiiiiiiiiiiicicec e 74
Construction step

Construction Protocol.........cc.ccevvevenenencncnenennen. 11

NaVIigation Bar ......c.oecvveeiiriiiiiieeiieeee e 11
Construction Step

COMMANG ..ot 40
Construction Tools. .6,16

ACTIVALE. .o 16
CoNteXt MENU .....coiiiiiiiiiiee e 10

ANIMAtION ON ..oeiiiiiiiieecee e 10

Copy to INPUE Bar....coiiiiiieeieiiieeeeieeee e 10

DEIELE ..t 10

RENAME ..ot 10

Trace ON oot 10, 88

Trace to Spreadsheet........cccoceevvevveneeneeneeneeenieenn. 10
Continuity, Options MenuU .......ccccovcuvieeiiniiiiieeniieeeeens 75
Convert

Degree to radians
Radians to degree
Coordinate axes

CUSTOMIZE .ttt
ShOW / i@ttt
VIEW MENU ..ttt
Coordinate grid
CUSTOMIZE cuvvveeieeietee et inaes 9
ShOW / Ride..ueceeeieectieteeecceece et 9
VIEW MEBNU ..eeviieeiciieeececiteee et e e 73
COOrdINAtES...veeeiieeiieeeiee et e e s 33
Cartesian coordinates.......ccccueevveeecveeeieeeeiveeeieeeenns 33
Coordinate Style, Settings .......ccoceveverencnincnnennene 12
Coordinates style, Options Menu. .75
Polar coordinates ........cccceeuveenne .33
x-coordinate ..... .35
JeleTe] o [T o - ) IR 35
Copy
Copy to Input Bar, Context MenuU.......ccccoveuvveeeennnns 10
Copy Visual Style, tool ......cccvveeviieecieeciieecieeeee s 17
Corner, COMMaANd .....cccuvieeeeiiieeeeeeeiree et e eereeee e e 46
Correlation Coefficient, command.........cccccceveeevuveeeennn, 64
Cosine, direCt iNPUL.....ccceeevveeciie e 35
Count If, commMaNnd ........eeeeviiveeeeeiiriee e 58
Covariance, COMMaNd .........ccccveeeiuveeiiveenireesreeereeeeenees 64
Create New Tool, TOOIS MENU ....ccvvevveeecnveeereeccieeenen. 76
Cross Ratio, command...........

Cubic root, direct input
Curvature

CoOMMANG ..ovviiiiciieee e 42,54

Curvature Vector, command .........cccceeveeeeennnnnns 47,54
Curve

COMMEANG ..ot sae e 53
Customize
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D

Decimal places, Options Menu .......cceecveeeveveenveesiveeennns 75
Decimal POINt....c.uecciieciieeie e 32
Definite integral .......ccccveeeieeccieeceecee e, 42
Area........... .42
Area between two functions .. .42
Definition, insert in INput Bar.......c.ccoceeveeeiienieienenienne. 31
Degree
Convert to radians ......c.eovveeereeeniieeeniee e 32
SYMDBOL ..t 24,32
Delete
COMMANG ..eiiiiiiieiiee e saee e 40
CoNteXt MENU....ccoiiiiiieiiiieeee e 10
Delete Object, t0O ....cccevveveereerieeriecrieceee e 17
EdIt MENU oot 72
TrACE ittt e s 74
Dependent 0bJeCt ......ccccueiviieeiiieeeeece e 7
Derivative, command... ..52,54
Determinant, command........ccocveeeeeciveeeeeeiinneeeeeeireeeeens 67
Dilate
COMMANG ..eviiiiiiciee et nae e 61
Dilate Object from Point by Factor, tool.................. 25

Direct input

Vectors.
Direction, command .

Directrix, command ........ccccevevveeeeeeiiriee e 49
Distance

COMMANG .ottt 42

Distance or Length, tool.......ccccccvininininiinicicnee 24
DiV, COMMANG ....veiiiiieciieeie ettt 42
Division, direct input.....c..coceeeeeeceenieiincncneneseceee 35
Drawing Pad, Options MeNU .......ccccevrveeriieernieeniieeenns 76
DYNAMIC COIOTIS...uiiiieiieiiiiisieste et re e 82
DYNamiC teXE .ccivueiiiiieiiiiiee et 27
Dynamic Worksheet

Edit aPPIet cveeeeeecieeeeeee e 15

Edit text ..

Export ....ccceuues

Export, File Menu ...

JAVA i

Edit MENU .ot 71
Delete oot 72
Export Graphics View to Clipboard.. .72
Properties Dialog.......c.ccccueveuennes .73
Redo........ .71
SEIECT All ..ttt 72
Select ANCESTONS ....ovvereiiiieiieieeeeieee e 72



Select CUrrent Layer .....oovveeeeeeerieeeceeesieescee e 72

Select Descendants.......ccccveeveeeerieeeieeeniee e 72

L7 3To Lo TSI 71
Edit object.............. .31
Element, command........ccoccuveeeeeciiiee e 58
Ellipse

COMMANG ..ot ere e 51

B oo ] PO SRS PRRR 22
EMF fOrmat...ccueeecueeecieeciie et e 71
Enlarge

COMMANG ..ottt 61

Enlarge Object from Point by Factor, tool ............... 25
EPS fOrmMat .o.veeeveiieieeieeieete ettt 70
EUlEr CONSEANT....ccveiieiieiecicct et 32
Expand
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Polynomial
Exponential function, direct input ..

Exponentiation, direct input.........ccccvvevieeiiieecieecieenn,
Export
Construction Protocol as webpage.......c.ccccvveevueenne 12
Dynamic Worksheet ........cccccoeeveeviiencieecieeceeeen, 14
Files created .......cooeeveeiinienieee e 15
GGB fileS et 15
Height / Width ...c.ooveviieeieieicceeeee e 14
HTML Il et 15
JARFIlES oo 15
ShOW reset iCON .....ovevveririeiceeieceseee e 14
Show TOOIbar .....oovevviiinirieeceeceeee 14

Tab Advanced.
Tab General

Dynamic Worksheet as Webpage, File Menu..........70

File MENU.coetiieiiieceeectee et 70
Graphics View

as PGF/TIikZ, FileMenU........ccccooeeveveeeeecviecieeeenne 71

QS PICtUIE .o 13

as Picture, File MeNU......c.cccovvvevieeiciieeciee e 70

as PSTricks, File MeNnU .......cccovvevieeecieeeciiecceeens 71

AL SCAIE i 14

to clipboard .....cccoevevininiicce 14

to Clipboard, Edit MenU .........ccceevieniiniienieneene 72

to Clipboard, File Menu.........cccccevenincncncnnnnne. 71

Interactive webpage......... .14

Interactive worksheet. .14

Export rectangle........ .14

Extremum, command ........ccceeeeeeirieeeeeiieeee e e s 46

F

Factor, command........cccooeviveeiieiiiiee e
Factorial, direct input
Factorise, command .

FIle MENU ..ottt
ClOSE .ttt
Export

Dynamic Worksheet as Webpage (html)............ 70
Graphics View as PGF/TIKZ ......cccccvevvrveneenenennen 71
Graphics View as Picture (png, eps) .......cccveeuenne. 70
Graphics View as PSTFiCkS .......cccceevineneneeneenene 71
Graphics View to Clipboard........c.ccccevvevineeunnee. 71

Filling, Properties Dialog
First axis

Command .......cceeevveennnne ..50

First Axis Length, command.......c..cccecevcvriveiincnnenne. 44
First, command .......ccoeeoveeiieeciieeccree e 58
Fit commands

FitEXp, commMand .......ccceeovevienieneninenenneceeeeeee 64

FitLog, command .........cccevuevienienineneneneneeeeenes 64

FitLogistic, command..........cccceeveninenencninieienenes 64

FitPoly, cOmMmMand........ccocveveeveenieenieereeesreeie e 64

FitPow, cOommand.........ccoveeeeeiiieee e cciieee e 64

FitSin, command .......cccoecvieeieiiiieee e 64
Fit Line
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Fit Line X, command .. .64
Floor, direct input .. ..36
FOCUS, COMMANd ....oiiiiiiiieeeecirieee e eeciree e ee e e e e 46
Font Size

INCIEASE oottt e s s 13

OPtioNS MENU...cciiiiiiiieeiiiiiee et e e 75
Format, Copy Visual Style ........ccceeeveeeieeciieeeecee e 17
FOIMUIG ettt 27
Formula Text, command........ccceeeeveeeeeeeeireeeceeeeree e 55
Fraction Text, command .........cccceeeevvvereecciieeeeciireeee e 56
Fre@ ODJECT . .oviiiieiiciccteeee e 7
Function, command .........cccceevvieiiiiiiiee e 53
Functions

Dir€Ct iINPUL...eeeeiiiiieee it

Exponential function.. .

Limit to interval .....cocceevcie e

NQME oo

G

Gamma function, direct input...

GCD, COMMANd .....evviiiieeciiiee et eaae s
GeoGebra Forum, Help Menu........ccceevveeecieeeniveeniie e
GeoGebraWiki, Help Menu.........ccoocevvieriienvienienieneene
Geometric Transformations
TOOIS et 25
Graphics VIBW ...ccueevuiereereenieerieeieeie et 6
Create PICtUIeS ..ocoeveeiieeiiiiieee e 13
CUSEOMIZE .o 8
EXPOrt @s PiCtUre.....ccevvviiieiieiiiieeeeiiteeee e 13
EXPOrt at SCale ..ovveveeieeiieieeeeece e 14

Export to Clipboard....
Export to Clipboard, Edit Menu .

Geometric input... .16

IMOVE ODJECES ..veeeiieeiee ettt 7

PrINT e 13

Update Print PrevieW.......ccoccvveeceeeecieeeciee e 13

ZOOM .ttt ettt ettt et sbe e e s e e e e e ne e e nne e 8
Greatest Common Divisor, command............cccceeeevvenne 42
Greek letter, UPPer Case .......ccevererenenineeieiceenne 86
Grid
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LiNE SEYIE.ceiiie et 9
ShOW / i@t 9
VIEW MENU ..ottt 73

H

HCF, COMMANG....ciiiiiiiieeecitiee et enree e e ennnes 42
Help
CommMaANd SYNTAX ..cccveeeiiieeiieeciteeciee e eieeeee e e 7
INPUL Bar...ciiiiiiiieei et 7,31
Toolbar .... ...6
Help Menu............. .77
About / License.... .78
GeoGeEDra FOrUm . ...coueviiniiniinienteseeseeeee e 78
Ge0GEDLraWiKi ..ccecververeiriiririieiceeceeeee 78
LICENSE ettt 78
WWW.EEOZEDIa.0r ..cevieiieieeieeie e eresesee e 77
Highest Common Factor, command .........ccceeevevcvennnenns 42
Histogram, command ........ccocceevvuieeniieeeneeenieeeseee e 65
Horizontal Splitting, View Menu.........cccccecevevervencvennnnns 73
Hyperbola
COMMAND ..o 51
TOO ettt e 22
Hyperbolic
Hyperbolic cosine, direct input........ccccceevevveeceveennnen.

Hyperbolic sine, direct input .....
Hyperbolic tangent, direct input

If
COMMANG c..eiiiiiiiieeeee e
Conditional function
Image
Corner... ..46
DiISTOMT.ceeiiiiieeiittee e 28
Insert IMage, tool .......cccvvveeveevieriereere e 28
Properties DIialog......c.cccvereereereereeneeneenieesreesieenees 28
ROLATE ...ttt 28
SCAIE e 28
SPECIfY COrNEIS.......oocvvieeieecieece e 28
Imaginary unit
Increment, manual animation ........cccceeeveeeeeviiieee e, 80
INAICES ...ttt e 30, 39
Inflection Point, command .........cccceeeeeiieeeeeenivieee e, 46
Input Bar.......ccveeveennne .7,30
DireCt iINPUL..cceiieiee it 32
Help ... 7,31
HISTOMY et 31
ShOW INPUL....eeiieieeecie e 31
VIEW MENU ..eeviiiiieiiiiecceittee et 73
Insert
COMMEANG ..ottt 59
Definition in INPUE Bar ......ccccevcveevveenieccieeceeeee, 31
Insert IMage, toO0l ....oovveveciieree e 28
Insert Text, t0Ol ......cccuveeiieciiieeeeceee e 26
Name in INpuUt Bar.........coveeriiiieeiiiieee e 31
Value in INPUL Bar....c.cueeeveeeniieeiieecieeeieesee e 31
Insert Image, tool...... .28
Insert Text, tool............ ..26
Integer Division, command.........ccccecvevvevienenenenenennen. 42
Integral
COMMANG ..ot 42,53
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Definite integral.....cccccevveeevciee i

Indefinite integral .....cccoveveevcee e
Interactive webpage, EXPort......cccccevvveeeeceevnieessiee s
Interactive worksheet, Export..
Interface, CUSTOMIZE ....cvvveeeeiiieee e
Intersect

All intersection pPoints.........cccceevereneneerenenieeenns 18

Allow outlying intersection points.........cccceceeenennene 18

COMMANG .ottt e 46

Intersect Two Objects, toOl......cccceeveevieneenennienienne 18

One intersection PoiNnt.......cccecvenieniniinninneniecnn. 18
Intersection, comMmMand.........ccccueeevveeecieccciee e 59
Inverse Normal, command..........cccceeeeveeecveeeeneeniree s 65
Invert, CoMmand.......cccccuveeeiiiiieeeeeiieee e esvre e 68
Is Defined, command.......cccceeevveeeveeeireeccree e 40
Is Integer, command .......ccccueeeveeenieeciee e 41
Iteration
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Iteration List, command

J

JavaScript interface......cccceeeciececeeeeecee e 82
Join, command....

K

Keep If, command.......cccevviiivieenieecee e 60
Keyboard ShortCuts.......cccovveeeveeenieecie e 83

L

Labeling
OPtioNS MENU...cciiiiiiiieeiiiiiee e sreee e 75
SEEEINES evveeeieieee e 12
LAbEIS .. 87
CapLioN ..ccieiiiiiciicc 87
Name and value......cccceevvvvieiieecieeeeieeee e 87
SHOW / Nide ettt 87
Language, Options Menu... .76
Last, command................ ..60
LaTeX Formula Y
LAYBIS ettt 87
LCM, COMMANd ...oviiiiiiiiiee et vr e e 43
Least Common Multiple, command.........cccceeevverrurennen 43
Length
COMMANG ..ot 43, 54, 60
Distance or Length, tool..........cccceevviiieicieeiiieecieens 24
Letter To Unicode, command ........cccceeeeeviveeeeesivneeeenn, 56
License, Help MeNU.....cccccecueeeviiiecieecee e 78
Limit
Function to interval .......ccceeovveeeeieeiiiecciee e 35
Value of angle............ .33
Value of NUMDBEr.....c.coooviiiiiecieece e 33
Line
COMMANG .o 49
Dir€Ct INPUL...eiieieiiieee it 33
Line style, Properties Dialog ......cccvevveercveeeneeesinnnnne 10
Line thickness, Properties Dialog.......cccccceevvvervnennne 10
Line through Two Points, tool......c..cceevveevneeeniinennne 20
NAME oot e e e 30,33
Perpendicular Line, command........cccccecveevnveencinnnnne 50
Perpendicular Line, tool.......cccccecveeiviveeciie e 21



Linear Eccentricity, command.......ccccceevvveeriieeeniveecnnnns 43
List
Direct Input...
OPEIrAtIONS ...eeiiieiiiiiee ettt
Lists
AItioN e 37
Apply arithmetic operations...

Apply pre-defined functions... .37
COMPAre ...coiiiiiiiiiiiicc e 37
DiIVISION eettiiieeciitee st e e 37
MUItIPlICAtioN ..c.ovviiiriiciiiicicccic e 37
Pre-defined functions.........ccccovveevieneeneeniecnieenienee. 37
SUBLIaCtion .....oceevveiiriercereee e 37
LOCUS ittt e e e e e e e e e e e rae e eeeees 88, 89
CoOMMAND ..o e 58
TOON ettt e 25
Logarithm
base 10, direct iNPUt......ccccvveeriieerieeree e, 35
base 2, direct iNPUt.......ccccccveeriieeiieecee e, 35
natural, direct iNPUL........ccocveeriieecieeeee e, 35
Lower Sum, command .......ccueeeeeeiuveeeeeniireeeeeeerreeeeeennees 43
Lowest Common Multiple, command..........c.ccccveeunen. 43

M

Major AXis, COMMANd........ccevueeerveeiiieereeesiee e eveens 50
Manage Tools, TOOIS MENU........cceevvervuerienienienienieens 76
Manual animation........ccccveeeceeeeiieeesiee e 79
Matrices
AdItioN ..cvveeeieeceeceeeee e 38
Apply arithmetic operations.......c.cccceevnenenerennnnne. 38
COMMANDS....eviiiiieerieeeiiee et esre s e sireeseee 38
DireCt iNPUL..ccoiiiieiiiiecceee e 38
MUILIPlICAtioN coeveeeieececceecee e 38
OPEIrAtiONS ...eeiiieiiiiee ettt 38
0] o] 4 Lot 4o USRS 38
MaX, COMMANG .....ccoiiirieeeeiiee e e e 43, 60
Maximum, cOmMmMand.........ccceeeeeeiiveeeeeeineeee e, 43, 60
Mean
COMMEANG ..ottt e 65
MeanX, command ...........coecvvveeeeiiireee et 65
Meany, command .......ccceeeveeeiieeeiieeeee e 65
Median, command........cccveeeiieeeiireeiiee e 65
Menu
Bt oot 71
FILB ettt 69
Help ..... 77
Options... .74
Tools..... .76
View..... .73
Window .. .77
MENU IEEMS ...ttt 69
Midpoint
COMMANG ..o
Midpoint or Center, tool...
Min, COMMANd....cccoiirieieeecireee e
Minimum, command ..........ccoceeeeveeriieeenieeeree e
Minor Axis, COMMaNd.........ccoueeeiveeririeeireecree e e 50
MIXEA TEXE .. eeevrieeiee et ecree et re e eare e ae e e eaae e 27
Mod, COMMAND .....oeeeiiiiiiicciee e 43
Mode, commaNnd ........ceeevveiieeeiiiiieee e 66
Modulo Function, command .........cccceeevvveerireeecveecneenns 43
Move
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Move Drawing Pad, tool ... .17
.17
Multiplication, direct iNPUt ......ccceeeveeervieeriiercieeeiee e, 35

N

Name
COMMANG .eviiiiieeiee e 56
CONIC SECLION .evvveieeiiieee et 34
Insert in INPUL Bar.......ooocuvieeieiiiieeeiiiieeessiiiee e 31
LINE ctiee ettt 33
of conic section. ...30
of function . ...30
of line......... ...30
of point... ...30
of vector . ...30
Point .... .33
Vector ........ .33

Naming objects.. ...30

Navigation Bar ... .11

View Menu ... .. 74
NeW Point, t0O! ......oeieeiiiiee e 19
New Window

LAY L=T o 1 PP PP UPPURTRRROIRt 69

WiINAOW MENU...ccuiiiiiiieciie et 77
NEW, MENU .ccoeiiiiietttteeeee e 69
Normal, command .......ccccecevveevieeeciee e 66
Number

Direct iNPUL.....covviiiiiiiiiiiciccie 32

LIMIt ValUE oo 33

NAMIE oottt e 32

Object

Algebraic Notation ......ccceecveceeciiviesese e 10
ANiMation ON......cevviiiiiiiiiiiiiiie e, 10
Auxiliary 0bJeCt.......cccverieriiieeeee e 7
Change Value .........ecevviiviirieeeeeeeeee e 30
COlOT e 10
COMMANG .o 56
Copy to INPUL Bar......cueeeiiiiiiii e 10
DeIBLE ..ottt 10
Dependent 0bjeCt.......ccccuveeiiieeiiee e 7
Bt 31
Fast renaming .....cccveeeviiiieiiniiieee et 16
FIllING vttt 10
Free object.....covviiiiiniiiceciccce 7

Insert
Definition in INPUL Bar.......cccevvveevieecierienienienns 31
Name in INPUt Bar .......cooevviiieeiiiiiieeiiniieee e 31
Value in INPUE Bar......ccoocvevceeneeneenceneenie e 31
LiNG STYI ueeveeeiieeieeieete ettt 10
Line thickNess .......cceeveirieniiiieeeceeeeeeee e 10
NAME e 30
RENAME ...t 10
SEIECE .t 16
Select several 0bjects .......cccovcvevevieeviieeeiieeceeeee 16
SHOW / Ride..ccceviiieiieceeecece e 8
Size.......... .10
Trace On. ... 10
Visibility ..... ...10
0OpeNn, MENU ......occiiiiiiiiiiiiiii e 69



OPLioNS MENU ....eviiiiiiiiiieeeeeteee et 74
ANEIE UNit.uiiiiiiieeiieesieeeee et 74
CheckbOoX Size ......oovivieiiiieieeeeeeeeeeee e 75
Continuity ............
Coordinates Style.

Decimal Places.. .75
Drawing Pad .......cccoveveneiiniiieicieecrce e 76
FONT SIZE oot 75
Labeling .ecveuieieieiiieeee e 75
LanguUage ......ccooviiiiiiiiiii 76
Point Capturing......ccccevivviiniiniiniiiiiccicce, 74
POINt STyl 75
Restore Default Settings.......cccoceevvvereeneeneenieenieennn. 76
Right Angle Style.....coovvvierieeierieveeeee e 75
ROUNAING ettt 75
SaVe SELINGS...uveiiieiieeeeriieee e 76
Significant Figures...... .75
Osculating Circle, command .......cccceevveeeiieercieeeciennenen. 54

P

Parabola
COMMEANG ..ottt sae e 52
Tool.... .22
Parallel Line, tool ...... .21

Parameter, command..... .44
Parametric Curve, command ........ccccceeeeveevireeecveecneenns 53
Parentheses, direct iNnput.........ccceceeiecieciinincncncnenen. 35
Pause animation ......cccceeeeviiieee et 79
PDF fOrmMat..ccccieecieeceieeciee et e 71
Perimeter, ComMmand.........ccceeeeuveeiieeeieeecree e 44
Perpendicular
Perpendicular Bisector, command ..........ccccecvereennen 50
Perpendicular Bisector, tool .......c.ccceeevveriieeccirennnnen.
Perpendicular Line, command.........ccccevevveeruveennen.
Perpendicular Line, t0Ol.......cccccveevvieeriieecieeeieeee,

Perpendicular Vector, command..
PGF/Tikz
Export, File Menu

Pi
CoNSTANT coiiiiiiiiiiii e 32
SYMBO i 24, 32
Picture
Background image .......cccoveereevieneeneeneeseeesee e 29
DiISTOMT.ceeiiiiieeiiitee et 28
EMF fOrmat...cocceeceecieccesecseeseerie e 71
EPS fOrmMat...ccceceeeieviesiesee e 70
PDF fOrmMat .ocveeeeeeeeeieceeseeseese e e e 71
PGF/TikZ ..... .71
PNG format....... .70
PSTricks format. .71
ROLATE ...t 28
SCAIE et 28
SPECIfY COrNErS........ccevieeieeeiiecie e 28
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